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Rentals for Adagio 
 
Trademark  
 
Adagio® is registered a trademark of Softrak Systems Inc. Throughout this manual that trademark name 
is used. Rather than put a trademark symbol in each occurrence of a trademark name, we state that we 
are using the name only in an editorial fashion and to the benefit of the trademark owner with no 
intention of infringement of the trademark. 
 
License Agreement 
 
Dakota Software reserves the right to make improvements in the product described in the manual at any 
time and without notice. 
 
Disclaimer of Warranties 
 
The foregoing warranties and remedies are exclusive.  The program and related services are provided on 
an “as is” basis, and Dakota Software disclaims all other representations, warranties, conditions and 
guarantees of any nature or kind whatsoever, whether express, implied, or statutory, or arising from 
custom or trade usage or by any course of dealing or course of performance, including without limitation, 
with respect to the program and any related services.  Without limiting the generality of the foregoing:  
(a) Dakota Software does not warrant that this software is free of bugs, viruses, imperfections, errors, or 
omissions; and (b) Dakota Software specifically disclaims and excludes all express, implied, or statutory 
representations, warranties, conditions and guarantees:  (i) of merchantability; (ii) of fitness for a 
particular purpose; (iii) of non-infringement; or (iv) arising from course of performance, course of dealing 
or usage of trade.  If you are acting as a consumer, some jurisdictions do not allow the exclusion of 
implied warranties, so the foregoing may not apply to you. 
 
Dakota Software shall not be liable for any claims or damages caused by the operation of the program on 
other than the computer and operating system identified in the documentation, acts of abuse or misuse 
by you or modifications or unauthorized repairs.  Dakota Software shall not be liable for any loss or 
damage in connection with or arising out of the interruption or loss of use of the program or any other 
items or services provided by Dakota Software. 
 
You acknowledge that any data entry, conversion or storage is subject to the likelihood of human and 
machine errors, malicious manipulation, omissions, delays, and losses, including, but not limited to, 
inadvertent loss of data or damage to media that may result in loss or damage to you and/or your 
property, and/or your detrimental reliance on maliciously manipulated data.  Dakota Software shall not be 
liable for any such errors, omissions, delays, or losses. You are responsible for adopting reasonable 
measures to limit the impact of such problems, including backing up data, adopting procedures to ensure 
the accuracy of input data, examining and confirming results prior to use, adopting procedures to identify 
and correct errors and omissions, replacing lost or damaged media, and reconstructing data.  If you 
licensed a Trial Version, you acknowledge and understand that: (a) the Trial Version may be used for 
evaluation purposes only; (b) the Trial Version shall be operable only for sixty (60) days; and (c) upon 
expiration of the evaluation period, any data or other information used with, processed by and/or stored 
in conjunction with the Trial Version may be converted if you upgrade to the full retail product. 
 
Any reseller, installer or consultant is not affiliated with Dakota Software in any capacity other than as a 
reseller, installer or consultant of Dakota Software’s products and has no authority to bind Dakota 
Software or modify any license or warranty.  Dakota Software makes no representations, warranty, 
endorsement or guarantee with respect to the skills or qualifications of any reseller, installer or consultant 
and you are encouraged to independently investigate their skills and qualifications. 
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The software product, including the manual and media supplied, is copyrighted and contains proprietary 
information.  All rights are reserved.  The manual may not, in whole or in part, be copied, photocopied, 
reproduced, translated or reduced to any electronic medium or machine readable form without prior 
consent, in writing, from Dakota Software. 
 
Ownership Rights 
 
Rentals for Adagio is protected by United States, Canadian and international copyright laws and other 
intellectual property laws, and international treaty provisions. Dakota Software and its third party 
licensors, if any, retain all title to and, except as expressly and unambiguously licensed herein, all rights 
and interest in:  (a) the product, including, but not limited to, all copies, versions, customizations, 
compilations and derivative works thereof (by whomever produced) and all related documentation; (b) 
the Dakota Software trademarks, service marks, trade names, icons and logos; and © any and all 
copyright rights, patent rights, trade secret rights and other intellectual property and proprietary rights 
throughout the world in the foregoing.  You acknowledge that your possession, installation, or use of the 
product does not transfer to you any ownership, title, or interest of any kind to the intellectual property in 
the product, and that you will not acquire any rights to the product except as expressly set forth in this 
Agreement.  You agree that all backup, archival, or any other type of copies of the product will contain 
the same proprietary notices that appear on and in the product.  Should you decide to submit any 
materials to Dakota Software via electronic mail, through or to Dakota Software website(s), or otherwise, 
whether as feedback, data, questions, comments, ideas, concepts, techniques, survey responses, 
suggestions or the like, you agree that such submissions are unrestricted and shall be deemed non-
confidential upon submission.  You grant to Dakota Software and its assigns a non-exclusive, royalty-free, 
worldwide, perpetual, irrevocable license, with the right to sublicense, to use, copy, transmit, distribute, 
create derivative works of, commercialize, display and perform such submissions for any purpose 
whatsoever, commercial or otherwise, using any form, media or technology now known or later 
developed, without providing any attribution or compensation to you or any other person, without any 
liability whatsoever, and free from any obligation of confidence or other duties, and you agree, represent 
and warrant that all moral rights in the submissions are waived in favor of Dakota Software and its 
successors, assigns and licensees. 
 
Termination of Support and Other Services 
 
Software has a limited useful life for various reasons including changes in technology. You are free to 
decide and responsible for deciding when to upgrade the product.  Dakota Software reserves the right to 
terminate customer support and all other services applicable to the product in the event that the product 
has become inoperable or incompatible with current operating systems, hardware, add-on products, 
product updates and services or other technologies.  To obtain up-to-date information regarding which 
products, releases and related services are currently supported, contact a customer service 
representative.  If you are not operating a supported release or service, it may be necessary to license an 
upgrade or replacement product or service in order to continue to receive customer support and/or other 
updates.  Any updates licensed by you are considered part of the Program and subject to this Agreement, 
except to the extent a separate license agreement is provided in connection with such update.  Any 
replacement products or upgrades will be governed by a separate agreement. 
 
Copyright 2013 by Dakota Software, Inc. 
 
All rights reserved. 
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Installation and Registration 
 
To install Rentals for Adagio open the file that was sent to you by Dakota Software: 
 
RentalSetup.exe 
 

 Follow the installation procedure to completion.   
 If you wish to run the program on more than one workstation, you must install the program on a 

network drive, then do a workstation install on each additional workstation.  The workstation 
install will be installed with the product at the following location: 
\SOFTRAK\RENTAL\WKSETUP\WKSetup.exe. 

     
 Start the program and register the product.  You will find the Registration function under the 

Help menu.  
 

 
 

 Complete the form by entering in your company name and other information (excluding the serial 
number, install code and license number).  Also indicate whether you have purchased the annual 
upgrade plan.  If so, you will be entitled to program updates or enhancements that are released 
within the year.  Click OK, when you have completed the information. 

 
 Print this form and either fax it to Dakota Software (604) 648-9885 or email a copy to 

customerservice@dakotasoftware.com.  
 

 Dakota Software will issue you a serial number; install code and a license number. Enter this 
information into the appropriate fields and click OK.  The program will indicate that it is 
registered and ready for use. 
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Error Message Explanation 

The company name, address, zip/postal, 
phone, contact are all required fields. 
 
 

You are attempting to save the Product Registration 
form without completing the required fields. Either 
complete the information or click on Cancel to exit 
the form. 
 

The serial number, install code or license 
number is not valid. 
 

You are attempting to enter an invalid serial 
number, install code or license number. Please verify 
that the codes entered have been provided by 
Dakota Software or your Adagio reseller.  We 
recommend that you copy and paste this information 
for better accuracy.  The codes are specific to a 
particular product version and release.   
 

The company information has been saved, 
but the product requires a valid serial 
number, install code and license number. 

The registration information is partially complete.  
Please complete the process by entering the serial 
number, install code and license number provided by 
Dakota Software.  Once registered the product will 
be ready to use. 
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Data Creation & Opening Data 
 
Before using the Rentals for Adagio, you will need to create Rental data.  It’s recommended that you 
determine the drive, directory and data extension of your existing Adagio dataset.  You will need to 
create Rental data in the same location and data extension.  Sample data is provided at 
\SOFTRAK\RENTAL\SAMDATA with the extension, SAM. 
 
From the File menu, select Open 
  

 
 
Enter your User ID and Password. The default User ID is SYS and the default password is SYS.   If you 
choose to remember the login credentials, the fields will be recalled the next time you access the data   
 
If this is the first time you’re opening this database, click Create to create new Rental data.  Select the 
drive, path and extension for your new data set.  Adagio Receivables and Inventory Control data is 
required. 
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Once you have set up the data files, each time you start Rentals for Adagio the most recently opened 
data files will automatically appear in the Open dialog. All you will have to do is enter your User ID and 
password, then click Open.  The sign on process is the same as any other Adagio product. 
 
 
Error Message Explanation 

Rentals for Adagio data was not found. 
 

The program was unable to open data at the specified 
location and data extension.  If you have specified a 
mapped network drive, ensure that this drive is valid 
and active. 

Rentals for Adagio data already exists 
at this location.  Please choose an 
alternate directory or data extension. 
 

You are attempting to create Rental data in a location 
where data already exists.  Please choose an alternate 
directory or data extension 

A valid User ID is required before 
proceeding 

The user and/or password are invalid.  Confirm your 
login by reviewing the user setup in another Adagio 
product. 

Unable to create directory The directory cannot be created.  It could be due to 
your user rights, an invalid drive or directory name. 

Please enter a valid data extension 
 

The data extension is either missing or invalid. 

Unable to create a file at that location.  
Please check your data path. 
 

The program was unable to create data at the 
specified location.  Please confirm the data path, 
extension and your right to create data at that 
location. 

Unable to open data at that location.  
Please check your data path. 
 

The program was unable to open data at the specified 
location and data extension.  If you have specified a 
mapped network drive, ensure that this drive is valid 
and active. 

Rentals for Adagio data was not found. 
Do you want to create it? 
 

Rental data was not found at the specified location.  
Please confirm the data path, extension.  If this is a 
mapped drive, ensure that it’s active. 
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Program Startup 

To run the Rentals for Adagio, click the Rental icon on your Windows desktop.  If an icon isn’t provided 
you may need to start the program from the Windows Start Menu.  Look for Rentals for Adagio under the 
Start Menu. 

 From the File menu, select Open.  Enter SYS for the User ID and SYS for the Password. If you 
are logged in as the Administrator, you can setup new users and change the Administrator’s 
default password.   

 

 

Command Line Parameters 

Command line parameters are provided to simplify the login for users.  If you identify the User ID, 
Password, Data Path and Data Extension, the opening dialog will not appear.   Setting the login 
information is only applicable to offices where security is not a concern.  

To add command line parameters, click on the Rental desktop icon and right-click properties.  Add one or 
more parameters to the Target field.   

For example:  C:\SOFTRAK\RENTAL\BIN\rental.exe /usys /psys 

Available parameters are as follows: 

Parameter Description 
/u Allows you to set the default user.  Ex: /uSYS  

 
/p Allows you to set the default password. Ex: /pSYS 

 
/d Allows you to set the default data path.  

Ex: /dC:\SOFTRAK\RENTAL\DATA 
 

/e Allows you to set the default data extension. Ex: /eDAT 
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Company Profile 
 
This function allows you to enter your company information, contract options, security and integration 
with other Adagio products. 
 
From the Edit menu, select Company Profile or Profile from the Tool bar 
 
Enter in your company information. The company name will appear on the status bar and reports.   
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Contract Options 
 
Under the Contracts tab you may select your preferences for contract and quotes. 
 

 
 
 
Options Description 
Increment contract 
numbers 

Select this option to automatically assign the next contract number on 
new contracts.  The contract number will be formatted using the 
contract number format and the next contract number.  
 

Contract number format This option is only available if you have selected Increment contract 
numbers.  If you leave this field blank or some number, the program 
will assume you want to use a simple numbering system for your 
contracts.  For example, your contract numbers might be 100, 101, 102, 
etc.  If you would like to include a prefix and/or a postfix, specify an 
example as the format.  For example, CON0123-A, will use a prefix of 
CON and a postfix of –A.  The 0123 indicates a leading zero format.  
When a leading zero is indicated, the maximum contract number will be 
controlled by the specified digits.  In the example above, the maximum 
contract number will be 9999. 
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Next contract number This option is only available if you have selected Increment contract 
numbers.  This option allows you to change the numeric next contract 
number you create. Using the contract format above and next number 
of 100, the next new contract number would be CON0100-A.  
 

Increment quote numbers Select this option to automatically assign the next quote number on new 
quotes.  The quote number will be formatted using the quote number 
format and the next quote number.  
 

Quote number format This option is only available if you have selected Increment quote 
numbers.  If you leave this field blank or some number, the program 
will assume you want to use a simple numbering system for your 
quotes.  For example, your quote numbers might be 1000, 1001, 1002, 
etc.  If you would like to include a prefix and/or a postfix, specify an 
example as the format.  For example, QUT0123-Q, will use a prefix of 
QUT and a postfix of –Q.  The 0123 indicates a leading zero format. 
When a leading zero is indicated, the maximum quote number will be 
controlled by the specified digits.  In the example above, the maximum 
quote number will be 9999. 
 

Next quote number This option is only available if you have selected Increment quote 
numbers.  This option allows you to change the numeric next quote 
number you create. Using the quote format above and next number of 
100, the next new quote number would be  QUT0100-Q. 
 

Rental cycle decimals This option allows you to specify the number of decimal places when 
calculating, displaying and printing the rental cycles.  Select a number 
from 0 to 6.  The default is 2 decimal places, but it can be changed at 
any time. 
 

Calculate commission on Indicate how you calculate commissions, on either Sales or Margins. 
Sales will calculate commission on the total value of the contract 
(excluding taxes), while Margins will calculate commission on the profit 
margin (billed less cost) only. Commissions are shown on the 
Salesperson Commission report. 
 

Default salesperson Select the default salesperson assigned to each new contract.  If this 
field is left blank, the customer’s salesperson will be used. 
 

Default billing rate This option is only applicable if you’ve chosen to use the simplified 
billing method.  The default billing rate will be assigned to all rented 
items on contracts.  Choose one of your defined billing methods. 
 

Default rental period This option is only applicable, if you have not chosen Open ended 
rental contract.  Enter the default rental period assigned to new 
contracts.  This option will set the contract return (due) date from the 
start date. 
 

Open ended rental 
contract 

Select this option to default new contracts as open ended.  Ie.  The 
contract due (return) date is left blank.    
 

Prompt to re-open a closed 
contract 

Select this option if you’d like to be prompted to clear the close date, 
when you edit a closed contract.  If you re-open a contract, further 
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billing could occur. 
Open existing contract to 
detail grid 

Select this option, if you’d like the contract items to be the first visible 
tabbed page when editing a contract.  Alternatively, the 
contract/customer tab will be visible. 
 

Allow deletion of contracts Select this option, if you’d like the ability to delete contracts from the 
contract list window.  This option can also be controlled via the user’s 
group.  From an audit perspective, you might like to retain all contracts. 
 

Allow edit of line extension Select this option, if you’d like the option to override the contract line 
extension.  Alternatively, the extension field is disabled.  This option can 
also be controlled via the user’s group. 
 

Allow credits on contracts Select this option to permit the credit of contract lines.  This option can 
also be controlled via the user’s group. 
 

Discount miscellaneous 
charges 

Select this option, if your company’s discounts apply to miscellaneous 
charges. 
 

Display in descending 
order 

Select this option, if you’d like the contract list sorted in descending 
order.  ie. The latest contract is the first entry in the grid.  Sorting by 
customer or contract number is available by right clicking over the grid.  
 

Default return time to start 
time 

Select this option, if you want the return time to default to the start 
time.  If you’re not tracking billing by time, the return time should be 
the same as the start time.  Otherwise, a partial day could be billed from 
the time variance. 
 

Apply user ID to sales 
clerk 

If you’ve chosen not to define sales clerks, you can default the sales 
clerk field with the user’s ID.  The default sales clerk is assigned via the 
user’s group. 
 

Show all dates for new 
contracts 

When you create a new contract, you will be prompted for the order 
date and rental period.  Select this option, to show the expected ship 
date and receipt date on the new contract dialog.  If those dates are not 
visible, they will be assigned the order date.  
 

Default header description 
to first item 

Select this option, if you’d like the contract header description to be 
assigned the first item code entered on a new contract. 
 

Use header return as 
default 

This option is only applicable if you’ve chosen to use the simplified 
billing method.  Select this option, if you’d like the rental item’s return 
date to be assigned to the header return date.  Otherwise, the return 
date will be calculated from the item’s start date and the rental default 
period.   
 

Start new line from line 
type 

Select this option, if you’d like the focus to be on the line type, when 
entering new lines on contracts.  Otherwise, the initial focus will be on 
the item number. 
 

Visit item unit field Select this option, if you’d like to visit the unit field, when tabbing 
through contract detail fields.  



 
Rentals for Adagio Page 15 

 

Invoice Options 
 
Under the Invoices tab you may select your preferences for invoices. 
 

 
 
 
Options Description 
Invoice number format If you leave this field blank or a numeric, the program will assume 

you want to use a simple numbering system for your invoices.  For 
example, your invoice numbers might be 100, 101, 102, etc.  If you 
would like to include a prefix and/or a postfix, specify an example as 
the format.  For example, IN0123-A, will use a prefix of IN and a 
postfix of –A.  The 0123 indicates a leading zero format.  When a 
leading zero is indicated, the maximum invoice number will be 
controlled by the specified digits.  In the example above, the 
maximum invoice number will be 9999. 
 

Next invoice number This option allows you to change the numeric next invoice number 
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that is generated during billing. Using the invoice format above and 
next number of 100, the next new invoice number would be 
IN0100-A. 

Comments transferred to 
invoices 

Select this option to transfer comments from the contract to the 
invoice. 
 

Include discounts in revenue 
accounts 

Select this option, if you want the revenue accounts to show the net 
amounts.  Alternatively, the gross amounts are applied to the 
revenue accounts, and the discounts to the discount account.  This 
option can be changed at any time, although care should be taken 
to allow for the desired audit tracking. 
 

Minimum rental amount per 
invoice 

If this value is a non-zero amount, Rentals will automatically set the 
rental amount to this value on all invoices which contain some rent 
if the actual rental amount is less than this minimum amount.  Sales 
and miscellaneous charges are not affected by this option.  It will 
not apply to credit notes or to the final rental amount when the item 
is returned, except when it is the only invoice for the contract. 
 

Tax status for minimum top-up 
amount 

For any invoice which has the minimum invoice amount applied (see 
the Minimum rental amount per invoice option), Rentals needs 
to know which tax status to assign in order for the amount to 
achieve the minimum amount specified. 
 

Print rental amounts if invoice 
is under minimum amount 

Choose this option to print rental amounts on invoices if the invoice 
is under the minimum amount.  For example, if you’ve set the 
minimum invoice amount to be $50 and the line item is only $10, 
you might want to hide the $10 line charge. 
 

Batch type Choose the batch type for invoices that are generated and 
transferred to Adagio Receivables. Select either Retrieve or 
Invoice batch.  If you generate invoices, several times a week, 
choose a retrieved batch, where invoices will be appended to a 
retrievable external file. Alternatively, an internal invoice batch will 
be generated for each billing run.  
 

Batch description Use this field to enter a default description for each new invoice 
batch created. You can use variables that will automatically enter 
specific information in the description. 

 Enter %seq to automatically include the billing sequence. 
 Enter %usr to automatically include the Adagio UserID of 

the person who created the batch. 
 Enter %unm to automatically include the Adagio User’s 

name of the person who created the batch. 
 Enter %sdt to automatically include the session date the 

batch was created. 
 Enter %bat to automatically include the batch number that 

was created. 
 Enter %dat to automatically include the system date the 

batch was created. 
 Enter %tim to automatically include the system time the 

batch was created. 
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Ready to post Select this option to set the A/R invoice batch as ready to post. 
Alternatively, the batch will be created as not ready to post.  You 
will have to manually set the status as ‘ready’, prior to posting. 
 

Date format Select one of the following formats for the %dat and %sdt 
variables to use in the Invoice Batch description: 

 Windows short - from Windows Regional settings 
 Windows long - from Windows Regional settings 
 Rpt. options (Hdr) - as specified in User Preferences | 

Report Options 
 Rpt. options (Det) - as specified in User Preferences | 

Report Options. 
 

Time format Select to use either a 12-hour or 24-hour time format for the %tim 
variable to use in the Invoice Batch description. 

Customer Options 
 
Under the Customers tab you may select your preferences from the following customer options.  All of 
these customer options can be overridden by the user’s group. 
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Options Description 
View customer info from 
contracts 

Turn this option off if you want to disable and hide the Customer 
button on the Contract form. If you don't want users to be able to 
edit customers directly while editing contracts, you will want to turn 
this option off.  
 

Check for customer on hold If you turn this option on, Rentals will warn you when you create a 
new contract for a customer that is on hold. You can then decide 
whether or not you want to continue creating the contract for the 
customer.  
 
 
 

Check customer credit limit If you want Rentals to automatically check the credit status of 
customers when you create new contracts, turn this option on. If 
the customer has already exceeded their credit limit, Rentals will 
warn you when you try to create a new contract for the customer. 
You can then decide whether or not to continue creating the 
contract for the customer.  
 

Allow credit limit override This option is only applicable to Check customer credit limit.  If 
this option is selected and the customer is over their credit limit, you 
won’t be able to create a new contract for the customer.  
 

Show customer alerts Select this option, if you’d like to see customer alerts while editing a 
contract.  
 

Show ship to alerts Select this option, if you’d like to see ship to alerts while editing a 
contract.  
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Item Options 
 
Under the Items tab you may select your preferences from the following item options and the simplified 
billing method. 
 

 
 
Options Description 
Cost to display Select from one of the costs defined in Inventory Control. This field 

is only active if the Display item cost info is selected. 
 

View item info Use this option to specify the level of item detail to display: 
 With cost, where items are displayed with price and cost 

information 
 Without cost, where items are displayed with only price 

and other item information, but no cost details 
 No access, where no item information will be displayed 

 
Start date phrase Select the phrase that will appear on the contract for the start date. 

 
Display item cost information Select this option, if you would like the item cost information to 
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display on the contract detail form. 
 

Warn if available quantity 
below zero 

Select to automatically create a backup of your entire dataset,  

Warn if IC quantity below zero You might turn this option on if you have the 'Allow inventory levels 
to be below zero' option turned on in Inventory's Company Profile. 
When this option is turned on in Rentals, if you try to sell an item 
that has a negative inventory quantity on hand, you will receive a 
Warning that 'There is insufficient stock at location xxx'. You will not 
be prevented from selling the item.  
 

Warn if price is below cost Select this option if you would like a warning if an item is sold below 
its cost.  Rentals will compare the price against the most recent 
cost. 
 

Warn if price is zero Turn this option on to suppress the warning that normally displays 
when you try to sell an item with a zero unit price. 
 

Sales location Select the location in Inventory Control, where items will be sold. 
 

Rental location Select the location in Inventory Control, where items will be rented. 
 

View IC item for rental item Select this option, if you would like use the item button on the 
contract detail form, to access the Inventory Control inquiry.  
Alternatively, the item button will access the rental item inquiry.   
 

Sort items by category Select this option, if you would like the rental item finder to sort by 
category.  Alternatively, the rental item finder will be sorted by item 
number. 
 

Rental category finder This option only applies to rental items on contracts.  Select this 
option, if you would like the category finder to show Inventory 
Control categories.  The alternative is rental categories, which 
assumes that you’ve defined rental categories in Rentals. 
 

Rental item finder This option only applies to rental items on contracts.  Select this 
option, if you would like the item finder to show Inventory Control 
items.  The alternative is rental items, which assumes you’ve 
defined rental items in Rentals. 
 

Show item alerts Select this option, if you would like to see Inventory Control item 
alerts, while entering items on contracts. 
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Availability Options 
 
Under the Availability tab you may select your preferences for the item availability function.   
 

 
 
The item availability grid can be customized to show select columns, column widths and colors for each 
item status.  Click the button adjacent to the status, to choose an alternate color.  The statuses: 
Available, Reserved and Rented are dependent upon their current status on active contract.  Ie.  Is the 
item currently rented or reserved on an active contract?  The statuses:  Servicing, Not Working and Sold 
are set by the user, under Rental Item Maintenance.   
 
The item availability grid will display a date range relative to today’s date.  Enter the start and end date 
to indicate how many days (before or after today’s date) you’d like to view.   
 
By default, a contract is deemed to start from the contract’s order date.  You can change that to start 
from the contract’s expected ship date, receipt date or rental start date.   
 
By default, an item is deemed to be rented/reserved from the contract start date.  You can change that 
to start from the contract order date, contract expected ship date, contract receipt date, item expected 
ship date or item start date. 
 
Items on the availability grid can be sorted by item or by category.  You can also indicate whether the 
rented item is reserved on the return date or not. 
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General Ledger Accounts 
 
Under the Accounts tab you can set the Adagio Ledger accounts that may be active when items are 
rented, sold or returned.  Accounts are also maintained in the category record, providing greater control 
over revenue allocation.  If the department field is left blank, Rentals will use the department defined in 
the Inventory Control location.  The discounts, inventory control, A/R clearing are not subject to the 
department override rule.  In addition, the miscellaneous charges file also contains G/L account 
information. 
 

 
 
Options Description 
First Invoice Rental Revenue Credit this account with the revenue generated on the first invoice.  

The offsetting entry is the Accounts Receivable clearing account.  By 
separating out the ‘first invoice’ rental revenue, you may defer 
revenue recognition off if you pre-bill the last month’s rental due. 
 

Rental Revenue Credit this account with revenue generated from the rental of an 
item (except for the first invoice). The offsetting entry is to Accounts 
Receivable Clearing.  If no deferral of rental revenue is done from 
first invoice billings, this account will be the same as the First 
Invoice Rental Revenue account. 
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Rental Estimated Cost You can track your ‘Cost of Rentals’ in order to assist in profitability 
analysis. You enter the rental cost in the same manner as you enter 
the rate amount to charge for an item.  This account is debited with 
an estimated cost of each rental billing.  The estimated cost of the 
rental is stored along with rates under rental item maintenance.  
 

Rental Estimated Cost Clearing Credit this account with the amount debited to the estimated cost 
account. This is a simple clearing account. You may use this to enter 
the actual costs recorded from Account Payable or Payroll. You may 
use the difference to determine how accurately you Accounts 
Receivable costing your rentals. From an accounting perspective, 
this is similar to using ‘standard costing’ in a manufacturing 
environment. 
 

Rental Sale Credit this account when rental inventory is sold to a customer. The 
offsetting entry is to Accounts Receivable Clearing. Note that when 
rental inventory is sold, a different G/L account may be credited 
than for sales of normal inventory. 
 

Rental Cost Of Goods Debit this account with the amount entered as the item cost when it 
is sold off. When an item is ‘Sold-Off’, the user is permitted to enter 
a cost (or value) of the sold item. The system will provide either the 
memo cost of the item from the serialized item file (if a serialized 
item is being sold), or the cost of the item from Inventory Control as 
a default to use. All costing methods in Inventory Control are 
supported. 
 

Rental Depreciation Clearing Debit this account with the difference between the value entered by 
the user for the item sold and the cost of the item recorded in I/C. 
(The difference must be depreciation) This is a clearing account as 
you will most likely wish to review and reconcile the entries made 
with the actual depreciation taken against rental inventory. 
 

Discounts Credit this account with any discounts taken by the customer. 
Discounts are controlled by the customer type and apply to all 
charges on a contract. 
 

Inventory Control Credit this account when items are sold. The offsetting entry is to 
A/R Clearing account. This account must match the account used in 
Inventory Control. 

A/R Clearing This is the offsetting debit account for recording sales and rentals. 
Make sure the account has the same number as Accounts 
Receivable. 
 

Top-up For Minimum Invoice 
Amount 

Credit this account when there is a top-up amount for a minimum 
invoice amount. 
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Sample Account Processing 
 
Given the above accounts, let’s trace through the accounting entries made in the life of a rental item (a 
36” projection TV).  The TV is purchased for $1000. The appropriate item number is added to inventory 
and a receipt is entered for the item.   
 
The receipt in Inventory Control generates: 
 
Account    Debit  Credit 
Inventory Control   $1000 
Receipt Clearing      $1000 
 
The television rents for $200 per month. The estimated cost (determined by the owner of the rental 
business) is $50/ month (based on a useful life of 20 months for the item.)  The television is rented to 
Ronald Black for 12 months payable monthly in advance. The last month’s rent is collected on the first 
invoice. 
 
The first rental billing generates the following transactions: 
 
Account    Debit  Credit 
First Invoice Rental Revenue    $200 
Rental Revenue      $200 
Accounts Receivable Clearing  $400 
Rental Estimated Cost   $100 
Rental Estimated Cost Clearing    $100 
 
Each subsequent billing cycle generates the following transactions: 
 
Account    Debit  Credit 
Rental Revenue      $200 
Accounts Receivable Clearing  $200 
Rental Estimated Cost   $ 50 
Rental Estimated Cost Clearing    $ 50 
 
At the end of the contract, Ronald Black decides to purchase the television. The net book value is $400 
($1000 original cost *8 months remaining / 20 months useful life,) the normal retail price is $1800, and 
50% of the rent is applied to the purchase price. Ronald is charged $600 for the TV.   
 
This is a selloff of rental inventory and is recorded as: 
 
Account    Debit  Credit 
Rental Sale      $600 
Accounts Receivable Clearing  $600 
Inventory Control     $1000 
Rental Cost of Goods   $400 
Rental Depreciation Clearing  $600 
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Integration Options 
 
Under the Integration tab you can customized how data is transferred to Adagio Receivables, Ledger 
and Inventory Control. 
 

 
 
Options Description 
A/R Send To Reference Select the default format or field that will be written to the reference 

field, when invoices are sent to Adagio Receivables. 
 

A/R Send To Description 1 Select the default format or field that will be written to the first 
description field, when invoices are sent to Adagio Receivables.  If 
the version of A/R is less than 9.0, there will only be one description 
field. 
 

A/R Send To Description 2 Select the default format or field that will be written to the second 
description field, when invoices are sent to Adagio Receivables. This 
option only applies to A/R 9.0 or higher. 

G/L Send To Reference Select the default format or field that will be written to the reference 
field, when transactions are sent to Adagio Ledger. 
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G/L Send To Description 1 Select the default format or field that will be written to the first 
description field, when transactions are sent to Adagio Ledger. If the 
version of G/L is less than 9.0, there will only be one description 
field. 
 

G/L Send To Description 2 Select the default format or field that will be written to the second 
description field, when transactions are sent to Adagio Ledger. This 
option only applies to G/L 9.0 or higher. 
 

I/C Send To Reference Select the field that will be written to the reference field, when 
transactions are sent to Adagio Inventory Control. 

 

Miscellaneous Options 
 
Under the Miscellaneous tab you may select your preferences for contract maintenance and printing.  
The maintenance date ranges will be used as defaults, when those functions are performed.  No 
automatic maintenance is performed. 
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Options Description 
Move to history after x days Indicate the number of days between the session 

date and the contract order date, before a 
complete contract is moved to history. 
 

Purge history after x days Indicate the number of days between the session 
date and the contract archive date, before an 
archived contract is purged from history. 
 

Purge completed after x days Indicate the number of days between the session 
date and the contract order date, before a 
complete contract is purged. 
 

Purge invoices after x days Indicate the number of days between the session 
date and the invoice date, before an invoice is 
purged. 
 

Prompt to consolidate G/L transactions Select this option, if you’d like to be prompted to 
consolidate the G/L transactions, after you print 
the G/L Transactions Report. 
 

Prompt to purge audit trail Select this option, if you’d like to be prompted to 
purge the audit trail data, after you print the Audit 
Report. 
 

Prompt to purge tax summary report Select this option, if you’d like to be prompted to 
purge the tax summary data, after you print the 
Tax Summary Report. 
 

Uses ranges for custom reports Choose whether to display ranges and options, 
prior to a custom report.  The ranges will be used 
to generate contract work files to be the basis of 
the custom report.  The alternative is to present 
ranges using Crystal Reports. 

Use ranges for custom views Choose whether to display ranges and options, 
prior to a custom view using GridView.  The ranges 
will be used to generate contract work files to be 
the basis of the view.  The alternative is to present 
ranges using GridView. 

Sort printed lines by Select how print contract lines will be sorted.  
Select either by line number, item code or item 
description. 

Default service code Choose a default service code that will be used 
when creating service records. 

Maximum displayed location rows Enter the maximum displayed locations when 
editing a contract rental or expendable item.  The 
contract detail dialog will resize to accommodate 
locations where the item is assigned. 
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Optional Fields 
 
Under the Contract Opt Flds tab you can define the contract header and detail optional fields.  Enter a 
field label, if you’d like to define an optional field.  Your choices are: String (text), Date, Amount (home 
currency decimal places), Unit (variable decimal places) or Boolean (checkbox).  Optional fields will be 
available for data entry on the contract header or detail forms.   
 
Under the Item Opt Flds tab you can define the rental item optional fields.  Rental item optional fields 
will be applied to the contract detail, if the labels correspond to one another. 
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Security, Group and User Setup 

Security 
 
The Group and User Setup function in Rentals for Adagio is where the System Administrator assigns 
individual users and groups access to specified areas. To ensure security of your system and your data it 
is essential that only those users or groups have limited access to specific areas as it prevents 
unauthorized users from entering the system. 
 
The Group Setup must be established first and then individual Users can be set up. For consistency you 
may want to use groups and users that are used in other Adagio software products. 
 
As a safety precaution you will not be able to disable the system administrator (SYS) from accessing any 
functions.  

Group Setup 
 
To create a New User Group 
 

 Select Group Setup from the File menu bar. This form will list all the user groups currently set 
up on your system. 

 To create a new user group, click New. The Edit Group window will open. Select from the drop 
down menu in the Group field, or enter in a new Group short name in the Group field and an 
expanded name in the Description field.  

 Deselect from the check boxes under Menu Access as to which areas this group will be permitted 
to view. Click on the expanded access box to view all the menu functions. 

 Set your preferences for this group.  These options will override global options in the company 
profile. 

 Click on OK to save. 
 
*Recommended* Disable the choice of ‘User Setup’ and ‘Group Setup’ under the File menu choice as 
this will prevent users from being able to edit their own group. 
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User Setup 
 
To differentiate between users, you must add each user to the system. At this time you can also specify a 
user group for each user. 
 
From the File menu, select User Setup 
 

 
 

 From this form you can select: 
 
New to create a new user  
Edit to modify an existing user 
Copy to copy the details to another new user 
Delete to delete a user 
Close to close the form  
 

Adding a New User 
 

 To add a new user click on New and the Edit User form will appear. 
 Enter in the initials, name,  
 Enter in Group, if applicable or select from the drop down menu.  The Group will be important if 

you wish to setup the menu level security or prevent posting. 
 Enter in password 
 Check the Edit Columns option, if grid column editing is permitted. 
 Check the Edit GridView option, if they can access GridView from this product. 
 Check the Enable SF Export option, if they can export from the Smart Finder window or a data 

grid. 
 Check the Enable SF Printing option, if they can print the Smart Finder results. 
 Click OK to save. 
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Error Messages Explanation 

You cannot delete the System 
Administrator 
 

You are attempting to disallow the system administrator (SYS) 
from accessing any functions. This is a safety measure in case 
you accidentally disallow everyone from a particular function. 
 

Error adding record to users, 
record already exists. 
 

You are attempting to use initials that are already in use. 

User's group cannot be blank 
 

You are attempting to close the form without assigning a 
group to the specific user. 
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Common Menu Functions  
 
The following functions are common to many of the Rentals for Adagio forms. 
 
Command Description 

New Creates a new record.  For example, a new contract, sales clerk or rental item. 
 

Edit Will allow you to edit or change a record you have already saved. Such as changing a 
contract.   To save time, press F2 from the grid, to edit a record. 
 

Delete Will delete the record highlighted in the form.  To save time, press DEL from the grid to 
delete a record. 
 

Find The find function will help you locate a particular record.  This is helpful if you have several 
records in the grid. You can also select what action to take upon locating, either 
highlighting it or making it available for editing.  
 

 
 
To save time, a shortcut to the find function is available from any grid.  Press F5 button to 
initiate a find with the finder window open.  Press F6 to initiate a find with the smart finder 
window open. 
 

Excel If you have Microsoft Excel installed, you can quickly export the entire list to a spreadsheet 
by clicking the Excel button. 
 

Close Will close the form you were currently on.  Pressing ESC will also close the form. 
 

Popup 
Menu 

If you right click over the grid, a popup menu of functions will appear.  The menu functions 
include those described above, as well as additional functions and sort options. 
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Customers  
 
Customers can be maintained in Adagio Receivables and Rentals for Adagio.  The functionality should be 
the same.  Please refer to the Adagio Receivables on-line help for information on customer maintenance.   
 
From the Edit menu (or tool bar), select Customers   
 
The customer list window will open, displaying all of your currently defined customers.   
 

 
 
To create a new customer, click New or the Insert key.   
 
To edit an existing customer, select the customer from the list and click Edit (F2).  If you have several 
defined customers, click Find (F5 or F6) to search for the customer. 
 
If you have Microsoft Excel installed, you can quickly export the entire list to a spreadsheet by clicking 
the Excel button. 
 
Click OK when you're done.  The category code will now appear in the list. 
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Ship To Addresses  
 
This function allows you to enter shipping addresses for all your customers. You can enter as many ship 
to addresses for each customer as you need. If you do not enter a Ship To address for a customer, the 
address on the customer record will then be automatically applied to ship to address on contracts.  
 
From the Edit menu, select Ship To Addresses or ShipTo from the tool bar. 
 
The ship to address list window will open, displaying all of the currently defined addresses.   
 

 
 
To create a new ship to address, click New or the Insert key.   
 
To edit an existing ship to address, select the ship to address from the list and click Edit (F2).  If you 
have several defined ship to addresses, click Find (F5 or F6) to search. 
 
If you have Microsoft Excel installed, you can quickly export the entire list to a spreadsheet by clicking 
the Excel button. 
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Field Description 

Customer code Enter the customer code for this ship to address. 
 

Ship to code Enter a code of up to six alphanumeric characters to identify this 
particular ship to address.  For example, a customer might have offices 
in Vancouver and Toronto.  The ship to codes could be VAN and TOR. 
 

Description Provide a description or name for this customer. 
 

Address Enter the address for this customer.  Four lines are available. 
 

Zip/Postal Enter the zip code or postal code 
 

Telephone Enter the telephone number 
 

Fax number Enter the fax number 
 

Tax group Enter the tax group for this ship to address.  This tax group will override 
the customer’s tax group.  Tax calculation is based upon the tax group. 
 

Price list Enter the default price list for this ship to address.  This price list will 
override the customer’s price list.  The price list will be applied to items 
that are sold. 
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Contact Enter the contact name for this particular address. 
 

Email Enter the email address for the contact 
 

Click OK when you're done.  The ship to address will now appear in the list. 
 
Error messages 
 
Error Message Explanation 

Ship to code may not be blank. 
 

You have neglected to enter a ship to code for this 
new address. 
 

That ship to address does not exist The program was expecting to find the ship to 
address.  This could indicate a data corruption 
problem.  Check the data integrity. 
 

The customer code is required You have neglected to enter a customer code for 
this new address. 
 

Tax group's currency must match the 
customer's currency 

The tax group’s currency does not match the 
customer’s currency.  This only applies to multi-
currency databases. 
 

The tax group ______ was not found. The tax group was invalid. 
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Sites  
 
Sites are useful for summarizing billing or reporting by job site or project.  Rental contracts are assigned 
a site code, identifying a customer’s job site. 
 
From the Edit menu, select Sites   
 
The site list window will open, displaying all of the currently defined job sites.   
 

 
 
To create a new site, click New or the Insert key.   
 
To edit an existing site, select the site from the list and click Edit (F2).  If you have several defined sites, 
click Find (F5 or F6) to search for the site. 
 
If you have Microsoft Excel installed, you can quickly export the entire list to a spreadsheet by clicking 
the Excel button. 
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Field Description 

Customer code Enter the customer code associated with this site. 
 

Site code Enter a site code of up to three six characters to identify this site. 
 

Description Provide a 2-line description of this site. 
 

Address Enter the address of this site. 
 

Zip/Postal Enter the zip code or postal code for this site. 
 

Telephone Enter the telephone number for this site. 
  

Fax number Enter the fax number for this site. 
 

Contact Enter the contact name for this site. 
 

Email Enter the email address for the site’s contact. 
 

 
Click OK when you're done.  The site code will now appear in the list. 
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Error messages 
 
Error Message Explanation 

Customer code may not be blank. 
 

You have neglected to enter a customer code for this new 
site. 
 

Site code may not be blank. You have neglected to enter a site code for this new site. 
 

Site code already exist You have chosen a site code that already exists for this 
customer.  Choose an alternate site code. 
 

Site code does not exist The program was expecting to find the site code.  This 
could indicate a data corruption problem.  Check the data 
integrity. 
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Categories  
 
Rental categories control the allocation of rental and sales revenue to the General Ledger.  If no 
categories are in use, the G/L accounts defined in the company profile will be used. 
 
If the department field is left blank, the renting location’s department will be used.  This is useful for 
departmentalized revenue reporting. 
 
Each item in Inventory Control is assigned a category.  You can use the same category or create 
subcategories that only exist for Rental items.  If you have a serialized inventory, you may assign a 
specific category. 
 
If you have a serialized inventory, you may assign a specific category. 
 
From the Edit menu (or tool bar), select Categories   
 
The category list window will open.  This window lists all of the currently defined categories.   
 

 
 
To create a new category, click New or the Insert key.   
 
To edit an existing category, select the category from the list and click Edit (F2).  If you have several 
defined categories, click Find (F5 or F6) to search for the category. 
 
If you have Microsoft Excel installed, you can quickly export the entire list to a spreadsheet by clicking 
the Excel button. 
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Field Description 

Category Enter a code of up to three alphanumeric characters to identify this 
category. 
 

Description Provide a description of this category code. 
 

First Invoice Rental Revenue Credit this account with the revenue generated on the first invoice.  The 
offsetting entry is the Accounts Receivable clearing account.  By 
separating out the ‘first invoice’ rental revenue, you may defer revenue 
recognition off if you pre-bill the last month’s rental due. 
 

Rental Revenue Credit this account with revenue generated from the rental of an item 
(except for the first invoice). The offsetting entry is to Accounts 
Receivable Clearing.  If no deferral of rental revenue is done from first 
invoice billings, this account will be the same as the First Invoice Rental 
Revenue account. 
 

Rental Estimated Cost You can track your ‘Cost of Rentals’ in order to assist in profitability 
analysis. You enter the rental cost in the same manner as you enter the 
rate amount to charge for an item.  This account is debited with an 
estimated cost of each rental billing.  The estimated cost of the rental is 
stored along with rates under rental item maintenance.  
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Rental Estimated Cost 
Clearing 

Credit this account with the amount debited to the estimated cost 
account. This is a simple clearing account. You may use this to enter 
the actual costs recorded from Account Payable or Payroll. You may use 
the difference to determine how accurately you Accounts Receivable 
costing your rentals. From an accounting perspective, this is similar to 
using ‘standard costing’ in a manufacturing environment. 
 

Rental Sale Credit this account when rental inventory is sold to a customer. The 
offsetting entry is to Accounts Receivable Clearing. Note that when 
rental inventory is sold, a different G/L account may be credited than 
for sales of normal inventory. 

Rental Cost Of Goods Debit this account with the amount entered as the item cost when it is 
sold off. When an item is ‘Sold-Off’, the user is permitted to enter a cost 
(or value) of the sold item. The system will provide either the memo 
cost of the item from the serialized item file (if a serialized item is being 
sold), or the cost of the item from Inventory Control as a default to use. 
All costing methods in Inventory Control are supported. 
 

Rental Depreciation Clearing Debit this account with the difference between the value entered by the 
user for the item sold and the cost of the item recorded in I/C. (The 
difference must be depreciation) This is a clearing account as you will 
most likely wish to review and reconcile the entries made with the 
actual depreciation taken against rental inventory. 
 

 
Click OK when you're done.  The category code will now appear in the list. 
 
Error messages 
 
Error Message Explanation 

Category code may not be blank. 
 

You have neglected to enter a code for this new 
category. 
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Miscellaneous Charges  
 
Miscellaneous charges are additional charges that might be added to a contract depending on the specific 
situation. For example, these charges might include handling, freight or packaging charges. 
 
From the Edit menu, select Miscellaneous Charges   
 
The miscellaneous charges list window will open, displaying all of the currently defined miscellaneous 
charges.   
 

 
 
To create a new miscellaneous charge, click New or the Insert key.   
 
To edit an existing miscellaneous charge, select the charge from the list and click Edit (F2) 
 
If you have Microsoft Excel installed, you can quickly export the entire list to a spreadsheet by clicking 
the Excel button. 
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Field Description 

Misc code Enter a code of up to six alphanumeric characters to identify this 
miscellaneous charge. 
 

Description Provide a description for this miscellaneous charge. 
 

Tax status Choose a tax status associated with this miscellaneous charge.  You’ll 
need to previously create tax types for this field. 
 

Charge amount Enter the amount that will be charged. 
 

Acct/dept Enter the General Ledger account and department that will be used for 
this miscellaneous charge. 
 

Print Select to print this miscellaneous charge as a separate line item on your 
contracts and invoices, or in the totals section of these forms.  You may 
override this selection in the specification of the specific document. 
 

 
Click OK when you're done.  The category code will now appear in the list. 
 
Error messages 
 
Error Message Explanation 

Misc code may not be blank. 
 

You have neglected to enter a misc code for this 
new miscellaneous charge. 
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Service Codes  
 
Service codes are used in conjunction with Service Records.  Service codes standardize the type of 
service that is performed on a rental item. 
 
From the Edit menu, select Service Codes   
 
The service code list window will open, displaying all the currently defined service codes.   
 

 
 
To create a new service code, click New or the Insert key.   
 
To edit an existing service code, select the service code from the list and click Edit (F2). 
 
If you have Microsoft Excel installed, you can quickly export the entire list to a spreadsheet by clicking 
the Excel button. 
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Field Description 

Code Enter a code of up to six alphanumeric characters to identify this service 
code. 
 

Description Provide a description of this service code. 
 

 
Click OK when you're done.  The service code will now appear in the list. 
 
Error messages 
 
Error Message Explanation 

Service code may not be blank. 
 

You have neglected to enter a code for this new service 
code. 
 

Service code already exist You have chosen a service code that already exists.  
Choose an alternate service code. 
 

Service code does not exist The program was expecting to find the service code.  
This could indicate a data corruption problem.  Check the 
data integrity. 
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Billing Methods  
 
Billing methods describe how rental charges are to be calculated, whether recurring invoices are to be 
generated, and how to calculate an expected return time for an item.  Billing methods allow you to tailor 
the rental charge out structure to your company’s method of renting equipment. 
 
Billing methods describe the method calculating rental charges.  Under Rental Item Maintenance, you can 
assign rates and cost to a particular item.  
 
Billing methods may be set up to charge a customer on an hourly, daily, weekly or monthly basis, as well 
as a flat fee. 
 
Flat rates not subject to recurring billing will appear on the final invoice to a customer. 
 
Flat rates subject to recurring billing will appear on every invoice generated for a customer.  
  
From the Edit menu, select Billing Methods   
 
The billing method list window will open, displaying all currently defined billing methods.   
 

 
 
To create a new billing method, click New or the Insert key.   
 
To edit an existing billing method, select the billing method from the list and click Edit (F2) 
 
If you have Microsoft Excel installed, you can quickly export the entire list to a spreadsheet by clicking 
the Excel button. 
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Field Description 

Description Provide a description of this billing method, with a maximum of 30 
characters. 
 

Rent is Select flat fee from the Rent cycle box if this rate is to be charged on a 
one-time basis. Flat fees marked as billable will be charged on every 
recurring invoice generated for a customer. Select per hour, per day, per 
week, or per month to specify the units to use in calculating the rental 
amount due. 
 

Free period A rate can have some amount of free time. This permits calculation of 
"5-day weeks" and other special requirements.  Free periods are always 
given at the end of the billing cycle.  For example, if an item rents for 
$100 a week, and each week includes 2 free days, Rentals allocates 1/ 
5th of the rate ($20) to each day of the 5 days that the item is rented; 
no charge is applied for the next two days. 
 

Calculations…should be Select Exact if rental fees for a partial cycle are to be calculated on an 
exact basis. For example, if a customer rents an item on a daily basis 
and returns it 28 hours after taking it out on rental, Rentals will charge 
the additional four hours as 4/24's of the daily rate. 
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Select Rounded to have Rentals automatically round up rental charges to 
the next highest whole unit of the rental cycle. To continue our example, 
the customer would be charged for two full day’s rental. 
 
Select Omitted (for daily rates only) to omit time.  For example, an item 
that is rented anytime on Jan.1 and comes back on Jan. 2 will be 
charged 2 days' rent.  For billable contracts, this also results in inclusive 
date ranges for invoice dates:  a 28-day rate would be billed Jan. 1 to 
Jan. 28, then Jan. 29 to Feb. 24, and so on. 
 

Grace period of x percent If the rent charged is to be in whole cycles only, you may wish to 
provide a grace period. Customers who return their rental items within 
the grace period will not have the rental fee rounded up to the next 
whole unit. Grace periods are calculated as a percentage of the rental 
cycle. For example, 50% of an hourly cycle is 30 minutes. 
 

Minimum rental period is If you wish to set a minimum rental period for an item, you would enter 
that information here.  For example, a monthly rate might have a 
minimum rental period of 3 months.  If a customer returns the item after 
only 1 month, the charge will still be for 3 months. 
 

Due date is To speed data entry, Rentals uses the rate selected when an item is 
rented to automatically calculate an expected due back date and time. 
Select start date plus to have the due back date calculated from the date 
rented. Enter the number of days, weeks, or months to add to the out 
date to provide an expected return date as a default. 
 
Select specific date if the expected due back date is always the same 
day. For example, weekend rental rates may always have an expected 
due back date of the Monday following the day the item was rented. 
 

Due time is Select start time plus and enter the number of hours and minutes 
to add in order to have Rentals calculate the due back time based on the 
time of day the customer rented the item. Select specific time and enter 
it in 24 hour format, if all your rentals are due back at a specific time of 
day. 
 

First invoice is First invoices to a customer may be calculated as either a percentage 
the total estimated rent, or a prebilling of a specific number of cycles. 
First invoices also include miscellaneous charges and expendables sold 
on the contract. 
 
Select a percentage of total estimated rent and enter the percentage 
you wish charged on the first invoice to the customer. If customer is to 
be charged in full for the rental on the first invoice, you may enter 
100%. 
 
Select a  pre-billing of so many cycles and enter the number- 
of cycles you wish to cover on the first invoice to a customer. 
 
These selections only apply to the first invoice generated from a 
contract, whether it is a cash or billable contract. 
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Recurring invoices will Select not be generated if you do not want recurring invoices created for 
this definition. Recurring invoices are only generated for rental contracts 
marked as billable. 
 
Select will be   generated to have recurring invoices produced and enter 
the frequency with which you wish to produce recurring invoices. 
 
You must specifically run the Recurring Billing function in order to 
generate recurring invoices. These selections control the frequency with 
which contracts will be selected by the Recurring Billing function. 
 

Billing: Advance or arrears To generate recurring invoices, Rentals must know whether rental 
amounts re charged in advance or in arrears. This allows it to track 
when the next recurring invoice should be created. Select advance to 
have your recurring invoices reflect rental charges collected in advance 
of the rental period. Select in arrears if you charge your customers at 
the end of a rental cycle for items they have out on a contract. 
 

Billing starting with month x Enter the number  of days, weeks, or months you wish to elapse before 
Rentals starts to generate recurring invoices on a contract. 
 

Invoice date Rentals allows you to synchronize all billing to occur on a particular day 
of the month, regardless of the day each item on the contract was 
initially rented. To always bill in whole periods, have the billing day be 
the same as the start day. To have all items on a contract billed as of 
the1st, 15th or last day of month, enter that day in the space provided. 
(All days after the 29th will be deemed the last day of the month.) 
 

 
Click OK when you're done.  The billing method will now appear in the list. 
 
After you have entered your billing methods, you will need to assign specific rates to your rental items. 
 
Error messages 
 
Error Message Explanation 

Category code may not be blank. 
 

You have neglected to enter a code for this new 
category. 
 

That billing method does not exist The program was expecting to find the billing 
method.  This could indicate a data corruption 
problem.  Check the data integrity. 
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Sales Clerks  
 
Sales clerk codes provide an additional audit trail and controls for your rental system.  The rental 
commission rate and sales commission rate are information fields only.  They may be useful for 
generating commission reports or views using GridView. 
  
From the Edit menu, select Sales Clerks   
 
The sales clerk list window will open, displaying all of the currently defined sales clerks.   
 

 
 
To create a new sales clerk, click New or the Insert key.   
 
To edit an existing sales clerk, select the sales clerk from the list and click Edit (F2).   
 
If you have Microsoft Excel installed, you can quickly export the entire list to a spreadsheet by clicking 
the Excel button. 
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Field Description 

Code Enter a code of up to six alphanumeric characters to identify this sales 
clerk. 
 

Name Provide a name for this sales clerk. 
 

Rental commission rate Record the rental commission percentage earned on rental revenue 
earned by this sales clerk. 
 

Rental minimum sales Enter the minimum rental revenue required of the sales clerk before the 
commission kicks in. 
 

Sales commission rate Record the sales commission percentage earned on sales revenue 
earned by this sales clerk. 
  

Sales minimum sales Enter the minimum sales revenue required of the sales clerk before the 
commission kicks in. 
 

 
Click OK when you're done.  The sales clerk will now appear in the list. 
 
Error messages 
 
Error Message Explanation 

Sales clerk code may not be blank. 
 

You have neglected to enter a sales clerk code for this 
new sales clerk. 
 

Sales clerk already exist You have chosen a sales clerk code that already exists.  
Choose an alternate sales clerk code. 
 

Sales clerk does not exist The program was expecting to find the sales clerk code.  
This could indicate a data corruption problem.  Check the 
data integrity. 
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Rental Items  
 
Rental items are used to record the rental rates, costs, comments, reference and notes.  All rental items 
are Inventory Control items.   
 
If your rental items are serialized, a unit field is available to uniquely identify the item.  A serial number 
field is also provided. 
 
Over time, you might like to know if a rental item has been profitable.  Rentals stores the original 
purchase price, rental revenue and cost, as well as costs from service records. 
 
A rental item history is provided, to view the current rental status and provide drilldown on rental 
contracts and service records.   
 
From the Edit menu (or tool bar), select Rental Items   
 
The rental list window will open, displaying all of the currently defined rental items.   
 

 
 
To create a new category, click New or the Insert key.   
 
To edit an existing rental item, select the item from the list and click Edit (F2).  If you have several 
defined items, click Find (F5 or F6) to search for the item. 
 
If you have Microsoft Excel installed, you can quickly export the entire list to a spreadsheet by clicking 
the Excel button. 
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Field Description 

Item number Enter a valid Inventory Control item number. 
 

Unit number If this is a serialized rental item, you may want to differentiate it from 
other items.  Enter a code of up to four alphanumeric characters to 
identify this item. 
 

Description The item description will default to the I/C item description, however 
you are permitted to change it. 
 

Serial number If this is a serialized item, enter the serial number. 
 

Category The category will default to the I/C item category, however you are 
permitted to change it an I/C category or Rental category. 
 

Status Choose either ‘active’ or ‘inactive’ 
 

Reference Enter a reference number for this item 
 

Comments Enter 4 lines of comments, with a maximum of 75 characters per line 
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Insert comments on 
contracts 

Select this option, if you would like to automatically insert the item 
comments when the item is added to the contract. 

Instruction Choose whether the inserted comments will appear as an instruction or 
comment.  Instructions are typically printed on internal documents. 

Transfer to invoice Choose whether the inserted comments will be transferred to the 
invoice at billing. 

 

 
 
The Rates tab is where you enter the rental rates and associated cost for each billing method.  If no 
billing methods are displayed, you should define at least one billing method. 
 
You can also specify the minimum amount to charge for the rental of this item. 
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The Optional Fields tab is where you can set values for optional fields.  If no optional fields are 
present, define labels for these fields under the company profile.  Choose the same labels as contract 
detail optional fields, if you’d like the data to appear on contracts.   
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The Statistics tab provides a summary of cost and rental revenue for this rental item.   
 
Enter the original cost (purchase price) for this item and the date that it was purchased. 
 
If you have entered any service records for this item, you’ll find the last service amount and service 
date. 
 
The total cost is an accumulation of service record costs and recorded costs from rental activity. 
 
The total rent is the recorded rental revenue from prior rental activity. 
 
All of the statistical fields are available for editing. 
 
 
Quantity statistics are also available for viewing on this tab.   
 
The quantity on hand (from Inventory Control) is the total number of units from all location, that 
haven’t been allocated to a sale or purchase order.  
 
The rented quantity is the number of units that are currently rented on contracts.   
 
The reserved quantity is the number of units that are currently marked as reserved on contracts.   
 
The available quantity is quantity on hand, less rented and reserved. 
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The History tab displays rental item activity from current or historical rental contracts.  Service 
records for this item can also be viewed.  To change the display, select Contracts, History or 
Servicing. 
 
For current or historical contracts, the last column in the grid will display the rental item status.  An 
‘O’ indicates that the item is currently rented (Out).  To drilldown to the contract, double click on a 
desired grid row.  Drilldown to the service record is also provided. 
 
The edit window is sizeable to accommodate additional grid columns. 
 
If you have Microsoft Excel installed, you can quickly export the entire list to a spreadsheet by 
clicking the Excel button. 
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The Notes tab allows you to maintain notes on each rental item.  Notes can be entered as a single 
memo (additional comments) or as separate notes by date/time/user/note.  An option is provided to 
sort the notes by user or date/time.   To insert a new note, double click on a blank row, click Insert 
or Right click to access the grid’s popup menu.  To edit an existing note, double click on the desired 
row, click F2 or use the popup menu. 
 
 

Click OK to record your changes.  The rental item will now appear in the list. 
 
Error messages 
 
Error Message Explanation 

Please enter a valid item number You have neglected to enter an item number for this new 
rental item. 
 

_______ is not a valid item number The item number is not a valid Inventory Control item 
 

_______ is not a valid category code The category code is not a valid Inventory Control 
category or a rental category. 
 

Failed to read that item 
 

The program was expecting to find the rental item.  This 
could indicate a data corruption problem.  Check the data 
integrity. 
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Service Records  
 
Service records are an historical record of the servicing that has occurred for a particular rental item.  For 
example, you rent a crane that requires periodic maintenance.  The profitability of a rental item can be 
calculated from the original purchase price, rental revenue, service costs and eventual sale.   
 
As an option, a service item can be associated with each service record.  For example, you may need a 
calibration device to service a rented monitoring device. 
 
With each service record, you can record the date, c, reference and description about that particular 
service record. 
 
You can define service codes to standardize the type of servicing that is required. 
 
From the Edit menu, select Service Records   
 
The service record list window will open, displaying previously entered service records.   
 

 
 
To create a new service record, click New or the Insert key.   
 
To edit an existing category, select the category from the list and click Edit (F2).   
 
Click Find (F5 or F6) to search for a particular service record.  The smart finder (F6) can be particularly 
helpful in finding a service record. 
 
If you have Microsoft Excel installed, you can quickly export the entire list to a spreadsheet by clicking 
the Excel button. 
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Field Description 

Record The record number to this particular service record.  The system generates a unique 
number and is read-only. 
 

Rental item Enter a rental item that is being serviced.  If this is a serialized item, enter the unit 
number following the rental item. 
 

Service item Enter an inventory item that will be used to service the rental item. 
 

Service code Enter a service code that identifies the type of servicing that will be performed.  That’s 
assuming that you’ve previously defined service codes. 
 

Description Two lines of text are provided to describe this particular servicing.  There is a 
maximum of 40 characters per line. 
 

Reference Enter a reference number for this servicing.  Enter no more than 16 characters.  
 

Date Enter the date that this servicing took place. 
 

Amount Enter the cost associated with this servicing. 
 

Click OK when you're done.  The service record will now appear in the list. 
 
Error messages 
 
Error Message Explanation 

Please enter a valid inventory item. The service record is either missing an item number or the 
item number is invalid. 
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Inventory Items  
 
Inventory items can either be maintained in Adagio Inventory or Rentals for Adagio.  The functionality 
should be the same.  Please refer to the Adagio Inventory on-line help for information on item 
maintenance.   
 
From the Edit menu (or tool bar), select Inventory Items   
 
The item list window will open, displaying all of your currently defined inventory items.   
 

 
 
To create a new item, click New or the Insert key.   
 
To edit an existing item, select the item from the list and click Edit (F2).  If you have several defined 
items, click Find (F5 or F6) to search for the item. 
 
If you have Microsoft Excel installed, you can quickly export the entire list to a spreadsheet by clicking 
the Excel button. 
 
Click OK when you're done.  The inventory item will now appear in the list. 
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Item Instructions  
 
Item instructions are lines of text that will automatically be added to a contract, whenever a particular 
item is rented. 
 
Create item instructions, if you find yourself repeatedly entering items and lines of text.  Using item 
instructions will save time and standardize the text that appears on your contracts.  For example: special 
handling or maintenance instructions. 
 
To create and edit your item instructions, select Item Instructions from the Edit menu.   
 
The item instruction list window will open, displaying all of the currently defined instructions.   
 
 

 
 
To create a new item instruction, click New or the Insert key.   
 
To edit an existing item instruction, select the instruction from the list and click Edit (F2).  If you have 
several defined instructions, click Find (F5 or F6) to search for the instruction. 
 
If you have Microsoft Excel installed, you can quickly export the entire list to a spreadsheet by clicking 
the Excel button. 
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Field Description 

Item number Enter an Inventory Control item number. 
 

Description This is a read-only field to display the item description. 
 

Instructions Enter up to 10 lines of text.  Each line can contain 75 characters. 
 

Insert as instruction Select this option, if you would like this text to appear as an instruction.  
Instructions typically appear on packing slips for the warehouse, but not on 
documents that are seen by the customer.  Alternatively, the text will be 
marked as a comment.  The printing of instructions and comments can be 
controlled on the print specification. 
 

Transfer to invoice Select this option, if you would like the text to be transferred from the contract 
to the invoice, when generating invoices.  Alternatively, the text will only appear 
on the rental contract. 
 

 
Click OK when you're done.  The item instruction will now appear in the list. 
 
 
 
Error messages 
 
Error Message Explanation 

Item code may not be blank. 
 

You have neglected to enter an item code for this 
new item instruction. 
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Suggested Items  
 
Suggested items will automatically appear whenever a specific inventory item is added to a contract. 
Suggested items can be either rental or sale items.  For example, when a piece of equipment is rented, it 
might require additional consumables. 
 
One method of increasing the revenue generated by your rental business is to ensure that your staff 
always suggests what may be appropriate expendables for your customer to purchase, or other 
equipment to rent at the time the initial contract is created. 
 
To create and edit your suggested items, select Suggested Items from the Edit menu.   
 
The suggested item list window will open, displaying all of the currently defined suggested items.   
 

 
 
To create a new suggested item, click New or the Insert key.   
 
To edit an existing suggested item, select the item from the list and click Edit (F2).  If you have several 
defined suggested items, click Find (F5 or F6) to search for the master item. 
 
If you have Microsoft Excel installed, you can quickly export the entire list to a spreadsheet by clicking 
the Excel button. 



 
Rentals for Adagio Page 67 

 
 
 

Field Description 

Item number Enter the item number that will trigger the suggested item(s). 
 

Description This is a read-only field to display the item description. 
 

Item type Choose whether to suggest a rental or item to be sold. 
 

Suggested item Enter the item number that will be suggested. 
 

Quantity Enter the default quantity for sale or rental of this item.  
 

 
Click OK when you're done.  The suggested item will now appear in the list.  Multiple suggested items 
can be assigned to the same item number. 
 
 
 
Error messages 
 
Error Message Explanation 

Item code may not be blank. 
 

You have neglected to enter an item code for this 
new suggested item. 
 

Please enter a valid suggested item 
number. 
 

You have neglected to enter the suggested item or 
the entered item is not a valid inventory item. 
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With the above example, two suggested items have been set up with item A1-N-1001.  When  
item A1-N-1001 is rented or sold, the two suggested items will be presented in succession.  To include 
the suggested item, click Yes.  To omit the suggested item and advance to the next suggested item, click 
No.  To exit the process, click Cancel.   
 
With each suggested item, the item number, description and default quantity will be applied to the 
contract detail.  Edit the rental or sales information as you would with any contract detail.  Click OK to 
continue with the next suggested item. 
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Tax Groups  
 
Tax groups are used to calculate tax on contracts and invoices.  Tax tables are useful for sales that are 
subject to more than one tax authority.  For example, sales in a rural area may be subject to only a state 
sales tax, whereas sales in a major city may have city sales taxes or special levies added to the state tax. 
 
Once you have set up the tax tables, all this work will be done for you.  When you enter a contract, 
rentals will look up the tax group assigned to that customer.  The tax group is a set of rules and rates 
used for taxing the various categories of items and vendors that may be included. 
 
From the Edit menu, select Tax Groups   
 
The tax group list window will open, displaying all of the currently defined tax groups.   
 

 
To create a new tax group, click New or the Insert key.   
 
To edit an existing tax group, select the tax group from the list and click Edit (F2).   
 
If you have Microsoft Excel installed, you can quickly export the entire list to a spreadsheet by clicking 
the Excel button. 
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Field Description 

Tax group Enter a code of up to six alphanumeric characters to identify this tax group. 
 

Description Provide a description of this tax group. 
 

 
 
With any new tax group, you will need to fill out each jurisdiction.  The Jurisdiction fields are described 
below: 
 
Field Description 

Jurisdiction The name of the jurisdiction (taxing authority). You can enter up to five 
jurisdictions for each tax group. You may find it easier to identify jurisdictions if 
you use their official names (State, Federal, New Hampshire, Phoenix, Chicago 
Transport, etc.) or some other name that is descriptive. 
 

Minimum Minimum tax that can be collected on an order/invoice for the jurisdiction. If 
the jurisdiction has such a minimum, enter the actual minimum in dollars and 
cents, complete with a decimal point. (If you do not enter a decimal point, the 
program will assume the amount is a full dollar amount). When a minimum is 
applicable and a tax calculated is less than this limit, no tax is applied. 
 

Maximum Maximum tax that can be collected on an order/invoice for the jurisdiction. If 
the jurisdiction has such a maximum, enter the actual maximum in dollars and 
cents, complete with a decimal point. (If you do not enter a decimal point, the 
program will assume the amount is a full dollar amount). When a maximum is 
applicable and a tax calculated exceeds this limit, the maximum tax is applied. 
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Acct/Dept The General Ledger account and department (if your company uses 
departments) to which you want to post collected taxes. Rentals requires that 
the account field contain a General Ledger account number for each item that 
includes an amount field, and for each jurisdiction. If any accounts are blank, 
an error occurs during posting, informing you that a blank account exists either 
in the line item information or in the tax table. 
 

Tax base Your entry in this field determines the amount for which the tax is calculated. 
You can tax the customer based on the Selling price, the Standard cost 
amount, the Most recent cost, or either of the two user-defined costs. The 
Selling price is most commonly used for tax purposes. 
 

On invoice as This field allows you to indicate where on the invoice the tax is displayed: either 
as a line item in the detail section, or as part of the total section. 
 

Taxable The taxes levied by one jurisdiction may themselves be taxed by another 
jurisdiction. Clicking this checkbox on means that the taxes themselves are 
taxable; turning this checkbox off means they are not. 
 
When calculating invoices for multiple jurisdictions, one or more of which is 
taxable, Rentals calculates taxes in the order in which the jurisdictions occur. 
When it comes to a taxable jurisdiction, it calculates the taxes for that 
jurisdiction and adds them to the total amount to arrive at a new tax base. 
Then it calculates the remaining taxes on the new base and adds them in to 
arrive at the total. 
 
For example, if a sale of $100 requires a 5% tax applied by a jurisdiction that 
taxes the taxable jurisdiction, Rentals calculates the total in this manner: 
 
$100 + (5% x $100) = $105.00 
+ (7% x $105) = $112.35 
Invoice amount            $100.00 
+ taxable tax (5%)            5.00 
New tax base               $105.00 
+ remaining tax (7%) 7.35 
Invoice total                 $112.35 
 

Customer Tax Rates Enter the customer tax rates for this jurisdiction. 
 
NOTE: The name of this field is defined in tax types. 
 

Item tax Rates Enter the item tax rates for this jurisdiction. 
 
NOTE: The name of this field is defined in tax types. 
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You can view totals for item tax rates and customer tax rates on the Item Rates and Customer Rates 
tabs. 
 
If you want to add more jurisdictions to this tax code, click the New button.  A new tab will be added to 
the window for the new jurisdiction. 
 
When you are done, click OK to add the new tax group or to save changes. 
 
 
Error messages 
 
Error Message Explanation 

Tax group code cannot be blank You have neglected to enter a code for this new tax 
group. 
 

The currency code cannot be blank For multicurrency, you’ll need to assign a currency 
code to each tax group. 
 

Invalid currency code The selected currency code is invalid.  Choose an 
alternate currency code. 
 

Invalid currency. For multi-currency only 
currencies with 2 decimals permitted 

The selected currency code is not a 2 decimal 
currency.  Choose an alternate currency code. 
 

Tax group already exist You have chosen a tax group that already exists.  
Choose an alternate tax group. 
 

Tax group does not exist The program was expecting to find the tax group.  
This could indicate a data corruption problem.  Check 
the data integrity. 
 



 
Rentals for Adagio Page 73 

Tax Types  
 
Tax Types are used in conjunction with tax groups.  You are permitted up to 10 different tax types for 
both customers and items. 
 
From the Edit menu, select Tax Types   
 
The tax type list window will open, displaying all of the currently defined tax types.   
 

 
 
Modify the tax type list, and then click OK to save your changes.   

 
  



 
Rentals for Adagio Page 74 

Ship Via  
 
Ship Via are shipping methods that can be referenced on rental contracts. You are permitted up to 10 
shipping methods. 
 
From the Edit menu, select Ship Via.   
 
The Ship Via window appears, with all existing shipping methods listed.  
 

 
 

Modify the shipping method list, and then click OK to save your changes.   
  



 
Rentals for Adagio Page 75 

Text  
 
Create text codes, if you find yourself repeatedly entering lines of text to contracts.  Using text codes will 
save time and standardize the text that appears on your contracts.  If the text is associated with an item 
number, perhaps Item Instructions are more appropriate. 
 
To create and edit your text codes, select Text from the Edit menu.   
 
The text list window will open, displaying all of the currently defined text codes.   
 

 
 
To create a new text code, click New or the Insert key.   
 
To edit an existing text code, select the text code from the list and click Edit (F2).   
 

 
 



 
Rentals for Adagio Page 76 

Field Description 

Text code Enter a code of up to 10 alphanumeric characters to identify this text. 
 

Description Enter up to 10 lines of text.  Each line can contain 75 characters. 
 

Instruction Select this option, if you would like this text to appear as an instruction.  
Instructions typically appear on packing slips for the warehouse, but not on 
documents that are seen by the customer.  Alternatively, the text will be marked 
as a comment.  The printing of instructions and comments can be controlled on 
the print specification. 
 

Transfer to invoice Select this option, if you would like the text to be transferred from the contract 
to the invoice, when generating invoices.  Alternatively, the text will only appear 
on the rental contract. 
 

 
Click OK when you're done.  The text code will now appear in the list. 
 
 
Error messages 
 
Error Message Explanation 

Please enter a text code. 
 

You have neglected to enter a text code for this block of text. 
 

That text code already exists. 
 

You have entered a text code that has been previously defined.  
Choose a new unique text code. 
 

That text code does not exist. 
 

An error has occurred while writing the text record.  It’s 
recommend that you run the data integrity checker to confirm 
that the data is error free. 
 



 
Rentals for Adagio Page 77 

 Active Users 
 
To view all users logged into the current dataset, select the menu option Active Users under the Help 
menu.  This function could be useful, if you are attempting to run functions that require exclusive access 
to the dataset.  
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Data Integrity Check 
 
It is recommended that you perform a data integrity checks on a regular basis.   
 
Select File…Data Integrity Check from the menu bar…Click Check 
 
Result of the check will appear and the function will inform you of the results.  If there are errors, the 
Rebuild button will be enabled.  Click Rebuild to fix the reported errors.  If errors are fixed, rerun the 
process to confirm that all errors have been fixed.   
 

 
 
Error Message Explanation 

It's strongly recommended that 
you make a backup, before 
repairing your data.  Do you 
want to continue?  
 

You are being prompted to run a backup before repairing any 
data. It is strongly recommended to do this to ensure there is 
a fallback dataset. 
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Currency Codes 
 
Rentals for Adagio allows you to set a default currency code, create a new currency code or edit an 
existing currency codes.  
 
From the File menu, select Currency Codes 
 

 
 
To add a currency code, select New and complete the edit form.  
 

 
 
Select OK to save your selection. 
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Workstation Options 
 
Use this function to set report preview options, default printers and specifications for contracts and 
invoices.   
 
From the File menu, select Workstation Options 
 
Enter the zoom factor as the default when you preview reports.  Additionally, select Full screen to 
have the Preview window occupy your entire screen size.  Select Partial screen to have the Preview 
window use part of the screen. 
 
Select Export to ExcelDirect tables to create a formatted table in Excel when exporting SmartFinder 
or grid results.  This option is only applicable to Excel 2007 or later. 
 

 
Settings Saved by Workstation 
 
The options you set on the Workstation Options window will be saved by workstation so that, if different 
users are connected to different printers, each user can set up their own printer options and other 
preferences without affecting other users. 
 
Other settings (eg. program, display report settings) are stored within a user's User Preferences.  Please 
refer to the online Help for more information about User Preferences. 
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User Preferences 
 
User preferences are used to set up Adagio user specific preferences for various report, display and other 
options in the module. 
 
From the File menu, select User Preferences. 
 
The By Application options will be active, regardless of the data that’s opened.  The By Company 
options will only be active for that currently opened dataset. 
 
Click Set All Users to make the option the same for all users. 
 

 
 
Field Description 

Toolbar Select this option, if you would like to display the toolbar. 
 

Toolbar text Select this option, if you would like to display the toolbar text below 
the images. 
 

Status bar Select this option, if you would like to display the status bar. 
 

Color Select this option, to customize the background color of the main form.  
Click Background to choose the color. 
 

Save window positions Select this option, if you would like the window positions to be 
recalled, the next time they are opened. 
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Save window size Select this option, if you would like the window sizes to be recalled, the 
next time they are opened. 
 

Auto-advance smart finder Select this option, if you would like the Smart Finder to automatically 
advance to the next record, when it’s reopened.  If you’re advancing 
through the search list, looking for particular record, you’d probably 
find this convenient. 
 

Alphabetically sorted field list Select this option, if you would like the grid and finder field list to be 
alphabetically sorted.  Alternatively, the field order will be the same as 
the file layout. 
 

Auto add items on documents When adding new lines to contracts, you might like the program to 
automatically start a new line, when you save the current line.  Choose 
this option to automatically add items on contracts. 
 

Auto edit items on documents When editing existing lines on contracts, you might like the program to 
automatically open the next line, when you save the current line.  
Choose this option to automatically edit items on contracts. 
 

Remember form settings When editing contract lines, you might like the program to use 
information from the current line, when you save the current line and 
start a new line.  Choose this option to remember form settings. 
 

On start-up There are several windows that can be opened automatically, when 
the dataset is opened.   Choose one or more functions. 
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Field Description 

Remember report settings The print options you select on report dialogs can be saved and used 
as the defaults the next time the report is printed. The options are 
saved by company, so if you set different options for different 
datasets, they will be saved accordingly.  To have your report settings 
saved, you must turn the Remember report settings option on. 
Report settings are only saved if you print or preview the report. You 
cannot simply open a report dialog, change the settings without 
printing or previewing, and have those settings remembered for the 
future. 
 

Close report dialog after print When this option is turned on, the report print dialog screen will close 
automatically after the report is printed.  This option can be useful if 
you’re printing the same report, multiple times with different criteria. 
 

Date format (Header/Footer) Select the date format, for dates that appear in the header and footer 
section of the report.  Indicate the date format to use on your reports. 
M stands for month, Y for year, and D for day. 
 

Date format (Detail) Select the date format, for dates that appear in the detail section of 
the report. Indicate the date format to use in the details on your 
reports. M stands for month, Y for year, and D for day. 
 

Time format Indicate the time format to use on your reports. H stands for hour, M 
stands for minutes. Use tt to indicate the position of am/pm. 
 

AM/PM format Select a format for the am/pm indicators. 
 

Show group tree in preview Select this box if you want a group tree displayed in the report review. 
You can use this group tree to quickly find account or department 
codes in a report preview.  The group tree provides quick access to a 
particular key field. 
 

Show parameters on all pages Select this checkbox if you want to include a description of parameters 
on all pages of a multi-page report. 
 

Show footers Click this box on if you want footers in your report. 
 

Shade header/footer Click this box on if you want headers and footers shaded with the color 
selected below. 
 

Shade subtotals Click this box on if you want subtotals shaded with the color selected 
in the field below. 
 

Shade color Select a color for shading subtotals, headers and footers. 
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Default print to file format When you print reports, you have the option to print to file. In this 
field, you specify the file format you would normally use when printing 
to file. For example, if you normally would want to open the printed 
data in Word, select Word. If you sometimes put reports on a company 
Intranet, you might select to print to HTML format instead. This is only 
a default; the Print Destination file format can be changed for specific 
instances of printing to file. 
 

Default print to file path Enter the path to the folder you want to store Inventory reports that 
have been printed to a Print Destination of File. 
 

Exclude ranges This option works in conjunction with Remember report settings.  
Select this option, if you would like to exclude ranges from those field 
values that are saved when the report window is closed.   
 

Copy starting to ending When entering ranges, you might like the starting value to be 
automatically copied the ending value, when the starting value is 
edited.  This can be a timesaver, if you’re printing a single document. 
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Backup 
 
Backing up your Rental data or your complete Adagio dataset, should be part of your daily or weekly 
routine.  Rentals for Adagio write to a variety of modules, including Adagio Receivables, Inventory 
Control, Ledger and Sales Analysis.  If the unexpected occurs, you will need to restore from a current 
backup.   
 
Before you perform your first backup, you should review the backup options.  In particular, you will need 
to indicate the location for storing the backup files. 
 
From the File menu, select Backup, then Backup Options 
 

 From the folder drop down list in the Zip Path field, select the directory where you 
would like the backup file to be stored 
 The Prefix is set at BKRN, but you may change this to any other 4 character prefix. 
 The Next Sequence field is a numbering system for backups. If “1” is displayed then 
the next backup will be “2”. You can modify this field to your unique specifications. 

 
 

 
 
 
From the File menu, select Backup, and you can choose either to backup Rentals Data or a Complete 
Dataset.   Since you are affecting changes across a variety of modules, a complete backup is 
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recommended.  Under either option, a zip file will be created in the backup directory.  Review the 
Backup Options for details. 
 
Selecting the Start button will commence the backup and a list of Added files will appear in the 
messages folder. Errors will be listed in the Error folder. You will be notified when the backup is complete 
and how many filed were zipped. 
 

 
 
Error Messages 
 
Error Message Explanation 

Backup completed ... Unable to 
backup _____. 
 

The backup was completed except for the file listed in the 
error message. Check the errors folder for more information. 
 

Backup aborted.  Directory does 
not exist. 
 

The directory that is specified in Backup Options does not 
exist. Please verify directory and retry backup. 
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Pre-Billing Register 
 
The Pre-Billing Register is used to produce a report of the activity and amounts that are to be charged 
should you elect to generate recurring invoices.  The Pre-Billing Register is an important control 
document.  It allows you to ascertain that the figures to be charged are accurate, the correct contracts 
are included on the list, and that the one-time charges and miscellaneous items entered since the last 
recurring billing run are correctly billed.  This function may be run whenever you desire.  Other than 
printing a report, it makes no changes to the database, and does not commit you to the amounts printed 
on the report. 
 
From the Billing menu, select Print Pre-Billing Register or 
From the Reports menu, select Billing Reports, then select Pre-Billing Register 
 
You may elect to generate recurring billing for ranges of customers or contract numbers. Remember that 
Rentals always knows to which date a customer has been billed on their rental agreement. You need not 
worry about customers being double billed for items out on rental. 
 
To ensure that invoices are generated according to the Pre-Billing Register, the Pre-Billing options will be 
used to Generate Invoices. 
 
After printing the report, verify that the figures and amounts are correct.  If adjustments must be made 
to the amounts or line entries, edit appropriate contracts.  If you’d like to exclude a particular contract, 
the contract can be placed on hold.  If you make modifications to outstanding contracts, you should 
repeat the procedure until the figures and amounts charged are correct. 
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Field Description 

Customers Enter a range of customers, you’d like to include in this billing 
cycle. 
 

Contracts Enter a range of contracts, you’d like to include.  Individual 
contracts can be excluded by placing them on hold. 
 

Detail level Select whether to print the report in detail or summary format. 
Detail format prints a line for all activity which has occurred on 
a contract since the Recurring Billing function was last run. 
Summary format condenses all of the activity on a single rental 
item to a single printed line of the report.  The Detail Report 
can be Discounted or Undiscounted. 
 

Bill as of Select a bill date. It may be convenient to set the date for a few 
days in the future to allow enough time to get the invoices in 
the mail and out to your customers. 
 
Remember, the charges incurred by your customer for this 
billing cycle are controlled not only by the rental activity that 
has occurred since the last billing cycle, but also by the rates 
set for each rental item. The billing methods control whether 
specific charges are incurred in advance or in arrears.  
 

Include rental items billed in advance Select this option, if you would like to include rental items that 
are billed in advance.   
 

Include rental items billed in arrears Select this option, if you would like to include rental items that 
are billed in arrears.   
 

Include zero amount lines Select this option, if you would like to include zero dollar lines. 
 

Include paid lines Choose whether to include returned items.  Fully paid, returned 
items will trigger an invoice unless they are suppressed. 
 

Include final invoice notices Select this option, if you would like to include final invoice 
notices.  If all items are returned but the contract remains open 
until after the subsequent invoice, a final invoice will be 
triggered when the contract is eventually closed, unless it is 
suppressed. 
 

Force billing of sale items Indicate whether you want to force the billing of non-rental 
lines.  For example, selecting "forced" will produce an invoice 
the next time billing is run, in the event that you add a 
miscellaneous charge midway' through a contract's duration. 
Alternatively, Rentals will wait until a rental line needs to be 
billed or the contract is closed before producing an invoice. 
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Here is a sample of the Pre-Billing Register: 
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Generate Invoices 
 
Use this function after you have verified that the information on Pre-Billing Register is correct.  The 
invoices generated during this step will reflect the quantities and amounts recorded on the Pre-Billing 
Register. 
 
From the Billing menu, select Generate Invoices 
 
Rentals will display the customer and contract ranges, dates and options used the last time the Pre-Billing 
Register function was run. 
 
When you’re ready to proceed, click Invoice to generate invoices. 
 
To view the new invoices, click Invoices from the Inquiries menu or click Invoices from the tool bar. 
 
Depending on the options set in the company profile, the invoices will be transferred to Adagio 
Receivables as a new invoice batch or appended to an retrieved batch.  Invoices will need to be posted in 
Adagio Receivables, before they become active. 
 
The next step will be to Print Invoices and the Invoice Audit Report. 
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Field Description 

Customers Enter a range of customers, you’d like to include in this billing 
cycle. 
 

Contracts Enter a range of contracts, you’d like to include.  Individual 
contracts can be excluded by placing them on hold. 
 

Bill as of Select a bill date. It may be convenient to set the date for a few 
days in the future to allow enough time to get the invoices in 
the mail and out to your customers. 
 
Remember, the charges incurred by your customer for this 
billing cycle are controlled not only by the rental activity that 
has occurred since the last billing cycle, but also by the rates 
set for each rental item. The billing methods control whether 
specific charges are incurred in advance or in arrears.  
 

Invoice date Select an invoice date that will be applied to all generated 
invoices. 
 

Include rental items billed in advance Select this option, if you would like to include rental items that 
are billed in advance.   
 

Include rental items billed in arrears Select this option, if you would like to include rental items that 
are billed in arrears.   
 

Include zero amount lines Select this option, if you would like to include zero dollar lines. 
 

Include paid lines Choose whether to include returned items.  Fully paid, returned 
items will trigger an invoice unless they are suppressed. 
 

Include final invoice notices Select this option, if you would like to include final invoice 
notices.  If all items are returned but the contract remains open 
until after the subsequent invoice, a final invoice will be 
triggered when the contract is eventually closed, unless it is 
suppressed. 
 

Force billing of sale items Indicate whether you want to force the billing of non-rental 
lines.  For example, selecting "forced" will produce an invoice 
the next time billing is run, in the event that you add a 
miscellaneous charge midway' through a contract's duration. 
Alternatively, Rentals will wait until a rental line needs to be 
billed or the contract is closed before producing an invoice. 
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Here’s a sample of invoice batch listing from Adagio Receivables.  The invoices were generated by 
Rentals for Adagio. 
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Print Invoices 
 
Invoices can be printed by selecting Print Invoices from the Billings menu or from Print Invoices 
from the Reports | Management Reports menu.   
 
Invoices should be printed, every time you generate recurring invoices.    
 
When you print invoices to a printer, the program will ask you if it printed OK.  If you click ‘Yes’, the 
invoice will be marked as printed.   If you un-select the option, ‘Include invoices that have already been 
printed’, previously printed invoices will be ignored. 
 
The format used for your invoices is controlled by the invoice specification.  Specifications are maintained 
under Maintenance… Maintain Specifications.  The default invoice specification can be selected from 
Workstation Options. 
 

 
 
Field Description 

Customers Select a range of customers that apply to these invoices 
 

Contracts Select a range of contracts that apply to these invoices 
 

Invoices Select a range of invoices to be printed.  If you’re attempting to 
print a single invoice, set that invoice to the starting and ending 
invoice range.  No other ranges are required. 
 

Sort by Sort the printed invoices, by Customer, Contract or Invoice.  
Sorting by customer can be a timesaver, if you mail multiple 
invoices per customer. 
 

Specification Choose an invoice specification that will be used to print these 
invoices.   
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Include invoices that have already 
been printed 

Choose this option is you’d like to print invoices that have 
already been printed.  
 

Current printer The current printer destination is displayed.  You’ll have an 
opportunity to change the printer, once you click Print.  The 
default printer can be selected from Workstation Options.  
 

Print Choose Print to print the invoice to a printer. 
  

Preview Choose Preview to preview the printed invoice in a window.  If 
acceptable, the invoice can be printed or exported from the 
preview window. 
 

Export Choose Export to export the report data to Excel, Word or 
HTML.   

 
 
Here’s a sample of a printed invoice: 
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Invoice Audit Report 
 
From the Billing menu, select Print Invoice Audit Report or 
From the Reports menu, select Billing Reports, then select Invoice Audit Report 
 
Printing the Invoice Audit Report completes the steps required to generate and print recurring 
invoices.  Once printed, you will be asked the clear the audit file, provided this option is set in the 
company profile. 
 
When you clear an audit file, you clear the content from disk, and cannot print additional copies of the 
audit report. This does not mean you clear the information added to Rentals by posting, as that data is 
kept in the posted contracts file rather than in the audit trail file. 
 

 
 
Field Description 

Detail level The audit report can be printed in summary or detail. 
 

Current printer The current printer destination is displayed.  You’ll have an 
opportunity to change the printer, once you click Print.  The 
default report printer can be selected with Workstation 
Options.  
 

Print Choose Print to print a copy of the report to the printer. 
  

Preview Choose Preview to preview the report in a window.  If 
acceptable, the report can be printed or exported from the 
preview window. 
 

Export Choose Export to export the report data to Excel, Word or 
HTML.   
 

Comment Choose Comment to add a comment to the footer of each 
report page. 
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Here’s a sample of the summarized Invoice Audit Report: 
 

 
 
 
Here’s a sample of the detailed Invoice Audit Report: 
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Archive Contracts 
 
From the Maintenance menu, select Archive Contracts 
 
The Archive Contracts function is used to archive a range of contracts all at once.   
 
Select a range of contracts using the starting and ending fields.  You can select a range of contracts, 
customers, completion dates or any combination of these. 
 
Only contracts that are closed will be archived. 
 
To be selected, a contract must meet all of the conditions. 
 
The contracts will be moved from current to history. 
 

 
 
Field Description 

Contracts Select a range of contacts to be archived. 
 

Customers Select a range of customers that apply to these contracts 
 

Completion dates Select a range of completion dates that apply to these contracts 
  

Proceed Choose Proceed to archive contracts that meet the range 
criteria. 
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Purge Closed Contracts 
 
From the Maintenance menu, select Purge Closed Contracts 
 
The Purge Closed Contracts function is used to purge a range of closed contracts all at once.   
 
Select a range of contracts using the starting and ending fields.  You can select a range of contracts, 
customers, completion dates or any combination of these. 
 
Only contracts that are closed will be purged. 
 
To be selected, a contract must meet all of the conditions. 
 
The contracts will be permanently deleted from the current contract list. 
 

 
 
Field Description 

Contracts Select a range of contacts to be archived. 
 

Customers Select a range of customers that apply to these contracts 
 

Completion dates Select a range of completion dates that apply to these contracts 
  

Proceed Choose Proceed to archive contracts that meet the range 
criteria. 
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Purge Invoices 
 
From the Maintenance menu, select Purge Invoices 
 
The Purge Invoices function is used to purge a range of invoices all at once.   
 
Select a range of invoices using the starting and ending fields.  You can select a range of invoices, 
contracts, customers, invoice dates or any combination of these. 
 
To be selected, a contract must meet all of the conditions. 
 

 
 
Field Description 

Invoices Select a range of invoices to be purged. 
 

Contracts Select a range of contacts that are associated with the invoices 
that will be purged. 
 

Customers Select a range of customers that are associated with the 
invoices that will be purged. 
 

Invoice dates Select a range of invoice dates that apply to these invoices 
  

Proceed Choose Proceed to purge invoices that meet the selection 
criteria. 
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Purge History 
 
From the Maintenance menu, select Purge History 
 
The Purge History function is used to delete a range of archived contracts all at once.   
 
Select a range of contracts using the starting and ending fields.  You can select a range of contracts, 
customers, completion dates or any combination of these. 
 
To be selected, the archived contract must meet all of the conditions. 
 

 
 
Field Description 

Contracts Select a range of archived contacts to be purged. 
 

Customers Select a range of customers that apply to these contracts 
 

Completion dates Select a range of completion dates that apply to these contracts 
  

Proceed Choose Proceed to archive contracts that meet the range 
criteria. 
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Apply Contract Styles 
 
From the Maintenance menu, select Apply Contract Styles 
 
Apply Contract Styles may be used to run one or more grid Filters and apply the filter Style to 
contracts meeting the filter criteria in one step. When a filter containing a Floating Date operation is 
run using Apply Styles, the date the filter used will automatically update based on the session date. 
 
Additionally, Apply Styles may be used to remove all Grid Filter styles previously assigned to records 
meeting the criteria of a filter. This may be a useful way to ‘clean up’, if multiple filters have been 
previously run and their styles applied to records perhaps making the grid appear too colorful. By doing 
this, you may be able to focus more clearly on just those records that meet the criteria for the filter(s) 
being run from this window. If a record meets the criteria for more than one of the filters being run, the 
filter style applied to the record will be determined by the Style Priority set within each grid Filter. 
 
If grids Filters are used, the Data Integrity Check function will reset filter styles used. For records that no 
longer meet any filter criteria, any filter style previously assigned to them will be removed and reset to 
the Standard style. For records that meet more than one grid filter criteria, the style will be reset to that 
of the filter containing the highest style priority. No messages or warnings will be given in DIC. 
 

 
 
Field Description 

Contracts Select a range of contacts to be archived. 
 

Customers Select a range of customers that apply to these contracts 
 

Completion dates Select a range of completion dates that apply to these contracts 
  

Proceed Choose Proceed to archive contracts that meet the range 
criteria. 
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Styles 
 
From the File menu, select Styles 
 
The Styles list window will open, displaying all the currently defined styles.   
 
Styles are useful for depicting which contract records meet the criteria of a particular Filter that has been 
run. For example, when the filter is run, records that meet the filter’s criteria can display in a certain style 
that is assigned within the filter. 
 
Additionally, the Standard style is where you define how a contract record appears normally and how it 
appears when selected (highlighted) during the regular course of working with Adagio. 
 

 
 
Creating a new or editing an existing style takes you to the Edit Style Codes window. 
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Field Description 

Style code If this is a new style, enter the name of the style you are 
creating. This code may include as many as 20 characters. 
 

Background color Clicking the existing color invokes a standard Windows color 
palette from which you may select basic colors or define custom 
colors to be used for the record’s Background. 
 

Font color Clicking the existing color invokes a standard Windows color 
palette from which you may select basic colors or define custom 
colors to be used for the Font in the record. 
 

Bold font / Italic font Select whether the Font will appear in Bold and/or Italic. 
 

Sample The Sample shows you what the result of the choices you’ve 
made will look like when this style is applied to a record that 
matches the criteria within a filter. 
 

Selected Only the Standard style has a Selected column. Each field in 
this column is set up in the same manner as in the Normal 
column. 
 
The Normal style shows how an item record will appear in a 
grid when this particular style is used (i.e. normally or within a 
filter). The Selected style is how an item record will appear 
when you select or highlight it for some purpose. 
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Contract Filters 
 
From the Contracts menu, select Edit Contract Filters 
 
The Contract Filter list window will open, displaying all the currently defined filters.   
 
Contract Filters can be useful tools for doing custom queries about the contracts. Once a filter has been 
created, filters are accessible from Contract maintenance and inquiry.  Contract Filters can use Styles so 
that, optionally, you may have contracts which match the criteria defined in the filter that’s been run, 
display the particular Style assigned within the filter. Additionally, filters may be Public or set to be run 
by an individual user only. 
 

 
 
Click the appropriate radio button to display only those filters in the grid. The default is Public; however, 
Adagio will remember whatever setting you used last. 
 
You may choose from: 

 All - Displays all filters for this dataset. 
 Public - Displays all filters having a ‘blank’ User Code. 
 Yours - Displays only the filters having a User Code equal to the User ID of the person logged 

into Adagio Payables. 
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Creating a new or editing an existing filter takes you to the Contract Grid Filter Edit window. 
 

 
 
 
Field Description 

User code If this query is to be run by a single Adagio user only, enter that user’s ID here or select it 
from the Finder. A Filter using a ‘blank’ user code will be available for all users to run (i.e. 
Public). A Filter having a specific user code (i.e. Yours) will only be available to run by that 
user when they are logged into this Adagio module. 
 

Description Enter an up to 40 character unique Description of your Filter.  This becomes the Filter 
code. 
 

Style 
priority 

If you have more than one Grid Filter created, it is possible that a contract might satisfy 
the criteria for more than one Filter. Entering a Style priority tells Adagio which Filter style 
has the highest priority and should be applied to an item satisfying multiple filters. A 
priority of ‘1’ is the highest priority; whereas a priority of ‘99’ would be the lowest priority. 
An easy way to remember this is “What is your #1 style?”. Style #1 is applied in 
preference to style #10 if a record is eligible for both styles. 
 
To ensure the style having the highest priority has been assigned to an item satisfying 
that filter’s criteria, run Data Integrity Check. No warnings or errors will be reported 
regarding filter styles; however, the styles will be reset accordingly. 
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Style code You may select a particular style that can be applied to contracts meeting the criteria 
within this Filter or choose to leave the Style ‘blank’. If you want to remove the Style color 
from this Filter at a later time, choose the Standard style. 
 
A Style must first be created before it will display in this dropdown. 
 

Query field Similar to working with the Smart Finder, select the field to query from the dropdown. 
 

Operation Select the operation to use with the query. 
 
When a Date field has been selected using the Floating date operation, you select what 
date(s) is meant to ‘float’ or be updated, based on the session date, when Apply Contract 
Styles is used and the filter is run. The date is automatically updated if the filter is run 
using the Apply Styles button or the Apply Contract Styles function. 
 

Select field When this option is off, the next field is used to enter a value for the query. 
When this option in on, you are able to select another field as the value in the query.   For 
example, the filter might be that the ‘Start’ must be ‘Equal to’ the ‘Expected Ship Date’. 
 
When a Date field has been selected using the Floating date operation, this option is 
always off enabling you to select what date(s) is meant to ‘float’ or be updated, based on 
the session date, when Apply Styles is used and the filter is run. The date is automatically 
updated if the filter is run using the Apply Styles button or the Apply Contract Styles 
function. 
 

Contact or 
field 

Depending on whether the prior field is turned on or off, you will either enter a value for 
the operation to act on here or select another field to be used instead. 
 

Boolean Use this field to include certain Boolean operators in your search such as AND, OR, AND 
NOT or OR NOT. Selecting one of these operators opens another filter criterion line. 
You may specify up to five separate criterion lines in this filter. 
 

 Button 
Click this button to remove the row of fields to the left of the button from your filter 
criteria. 
 

Sort by You may highlight and select (move to the box on the right) one or more fields to sort the 
filter results with.  
 
Fields in the ‘available’ box on the left are sorted alphabetically if you turned this option on 
in your User Preferences.  Selecting more than one field to sort by creates primary, 
secondary, tertiary, etc. sorts based on the order of selection (top to bottom). Once you 
have selected the field(s), use the other arrow keys to deselect (left arrow) fields or to 
move a field up or down to adjust its sort order. As well, you can select and right click on 
any of these fields to change its sort order from Ascending to Descending (or vice versa). 
In the case of a filter that has either never been run before or for which the Column Editor 
has not be used to change the displayed columns on the results grid, adding a field to the 
selected list will automatically add that field(s) to the results grid for the filter. For other 
filters, you can use the Column Editor to either manually add the new ‘Sort by’ field(s) to 
the filter’s results grid or click the Reset button and the Column Editor will do this 
automatically for you. 
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Reports 

General Information 
 
Report Options 
 
Adagio gives you control over the format of all reports. The report option allow you to set date and time 
formats, toggle headers and footers, and add shading to your reports, etc.  To access the report options, 
select User Preferences from the File menu. For more information about the report options, refer to 
the online Help documentation which describes this feature in detail. 
 
Previewing Reports 
 
Whenever you want to print anything in Rentals for Adagio, you are given an opportunity to preview that 
document. 
 
When you select the Preview option, the report will be printed to your screen, and displayed for you in 
the Preview window. 
 

 The arrow keys will allow you to scroll through pages of the document. Information about the 
number of pages is also displayed here, such as 1 of 2, to indicate this is the first of two pages in 
the document. 

 The Page Size button allows you to change the page magnification. 
 The smallest of three sizes will display the entire page in the window; the middle size will display 

the entire width of the page in the window; the largest size will display the document at full size. 
Click this button until you’ve reached the desired page size. 

 Click the Print button to print the document. 
 Click the Comment button to add a comment line to the footer of each report page. 
 Click the Export button to export the report data to Excel, Word or HTML.   
 The current printer destination is displayed.  You’ll have an opportunity to change the printer, 

once you click Print.  The default report printer can be selected with Workstation Options.  

General Reports 
 
The first group of reports under the Reports menu are the General Reports. These reports are used to 
print information from your data which is useful to file and keep for your records. 
 

 Ship To Addresses 
 Billing Methods 
 Rental Items 
 Item Instructions 
 Sales Clerks 
 Categories 
 Miscellaneous Charges 
 Company Profile 

 
All of these reports use the standard Reports windows which you will find are the same throughout all 
Adagio modules. Some of the General Reports, like the Ship To Address Report, include an option to 
select a range of data to include in the report. This allows you to print just a selection of the data if you 
don't need to print all the data for the given report. 
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Ship To Addresses Report 
 
To print a list of the Ship To Addresses you currently have set up on your system, use the Ship To 
Addresses report.  To print this report, select General Reports | Ship To Addresses from the 
Reports menu.  You can select a range of Customers using the Starting and Ending fields.  Or if you 
want to include all Ship To Addresses in the report, leave these fields as they are.  
 
Billing Methods Report 
 
To print a list of the Billing Methods you currently have set up on your system, use the Billing Methods 
report.  To print this report, select General Reports | Billing Methods from the Reports menu.  
 
Rental Items Report 
 
To print a list of the Rental Items you currently have set up on your system, use the Rental Items report.  
To print this report, select General Reports |Rental Items  from the Reports menu.  You can select 
a range of rental items using the Starting and Ending fields.  Or if you want to include all rental items 
in the report, leave these fields as they are.  Select whether to include the item details, rates and/or 
comments for this report.   
 
Item Instructions Report 
 
To print a list of the Item Instructions you currently have set up on your system, use the Item 
Instructions  report.  To print this report, select General Reports | Item Instructions from the 
Reports menu.  You can select a range of items using the Starting and Ending fields.  Or if you want 
to include all item instructions in the report, leave these fields as they are.  
 
Sales Clerks Report 
 
To print a list of the Sales Clerks you currently have set up on your system, use the Sales Clerks report.  
To print this report, select General Reports | Sales Clerks from the Reports menu.  You can select a 
range of Sales Clerks using the Starting and Ending fields. Or if you want to include all Sales Clerks in 
the report, leave these fields as they are.  
 
Categories Report 
 
To print a list of the Categories you currently have set up on your system, use the Categories report.  To 
print this report, select General Reports | Categories from the Reports menu.  You can select a 
range of Categories using the Starting and Ending fields.  Or if you want to include all Categories in the 
report, leave these fields as they are.  
 
Miscellaneous Charges Report 
 
To print a list of the Miscellaneous Charges you currently have set up on your system, use the 
Miscellaneous Charges report.  To print this report, select General Reports | Miscellaneous Charges 
from the Reports menu.  You can select a range of Miscellaneous Charges using the Starting and 
Ending fields.   
 
Company Profile Report 
 
This report can be accessed by selecting Company Profile from the Reports | General Reports 
menu.  This report prints all of your Company Profile settings.  When you’re ready to proceed, click 
Print.  
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Management Reports 
 
Management Reports can be accessed the Reports | Management Reports menu. These reports are 
used to print information about contract activity. 
 

 Contracts 
 Contract Listing 
 Rental Report 
 Revenue Report 
 Rental Item Activity Report 
 Conflicts Report 
 Delinquency Report 
 Tax Summary Report 
 Commission Report 

 
 
Contracts 
 
Contracts can be printed by selecting Contracts from the Reports | Management Reports menu.   
 
When you print contracts to a printer, the program will ask you if it printed OK.  If you click ‘Yes’, the 
contract will be marked as printed.   If you un-select the option, ‘Include contracts that have already 
been printed’, previously printed contracts will be ignored. 
 
The format used to print contracts is controlled by the contract specification.  Specifications are 
maintained under Maintenance… Maintain Specifications.  The default contract specification can be 
selected from Workstation Options. 
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Field Description 

Customers Select a range of customers that apply to these contracts 
 

Contracts Select a range of contracts to be printed.  If you’re attempting 
to print a single contract, set the contract to the starting and 
ending contract range.  No other range settings are required. 
 

Sort by Sort the printed contract, by Customer, Contract.  Sorting by 
customer can be a timesaver, if you’re printing multiple 
contracts per customer. 
 

Specification Choose a contract specification that will be used to print these 
contracts.   
 

Include invoices that have already 
been printed 

Choose this option is you’d like to print contracts that have 
already been printed.  
 

Current printer The current printer destination is displayed.  You’ll have an 
opportunity to change the printer, once you click Print.  The 
default report printer can be selected from Workstation 
Options.  
 

Print Choose Print to print the contract to the printer. 
  

Preview Choose Preview to preview the printed contract in a window.  
If acceptable, the contract can be printed or exported from the 
preview window. 
 

Export Choose Export to export the contract data to Excel, Word or 
HTML.   
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Contract Listing 
 
This report is used to print a list of contracts, in summary or detail.  For the latter, you can choose the 
line types that will appear on the report.   
 
To print this report, select Contract Listing from the Reports | Management Reports menu.   
 
 

 
 
 
Field Description 

Customers Select a range of customers that apply to these contracts 
 

Contracts Select a range of contracts to be printed.  If you’re attempting 
to print a single contract, set the contract to the starting and 
ending contract range.  No other range settings are required. 
 

Detail level Choose the level of detail to print.  Print in Summary or Detail. 
 

Contract Types Choose the source of the contracts.  Either current and/or 
archived contracts.   
 

Contract Status Choose to include contracts that are open and/or closed.  
 

Line Types Choose the line types to include on a detailed report.  
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Rental Report 
 
The Rental Report lists by quantity the rental and sales activity since the data was last purged.  If the 
report is printed by Open Contract History, it lists the history of rentals and sales for a range of contracts. 
 
To print this report, select Rental Report from the Reports | Management Reports menu.   
 
 

 
 
 
Field Description 

Customers Select a range of customers that apply to these contracts 
 

Contracts Select a range of contracts that will be reviewed. 
 

Detail level Choose the level of detail to print.  Print Rental Summary or 
Open Contract History. 
 

Sort by Choose to sort by Customer, Contract, Item or Category. 
 

Contract Types Choose the source of the contracts.  Either current, archived, 
quotes or a combination of those types.   
 

Contract Status Choose contracts that are open and/or closed.  
 

Line Types Choose the line types to include on a detailed report.  
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Revenue Report 
 
The Revenue Report allows you to review your rental revenue history by customer, contract, item or item 
category.  Options permit selecting rental, sales, revenue or both for reporting purposes.  Ranges of 
dates, customers, contracts, and items permit zeroing in on management information you require. 
 
To print this report, select Revenue Report from the Reports | Management Reports menu.   
 
 

 
 
 
Field Description 

Customers Select a range of customers that apply to these contracts 
 

Contracts Select a range of contracts that will be reviewed. 
 

Items Select a range of items that will be reviewed. 
 

Date in/Due Select a date range 
 

Sort by Choose to sort by Customer, Contract, Item or Category. 
 

Revenue type Choose the source of revenue.  Either Rentals, Sales or both. 
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Rental Item Activity Report 
 
This report allows you to view the status of rental items over a user specified period of time. 
 
To print this report, select Rental Item Activity Report from the Reports | Management Reports 
menu.   
 
 

 
 
 
Field Description 

Contracts Select a range of customers that apply to these contracts 
 

Items Select a range of contracts to be printed.  If you’re attempting 
to print a single contract, set the contract to the starting and 
ending contract range.  No other range settings are required. 
 

Rental Period Choose the level of detail to print.  Print in Summary or Detail. 
 

Contract Types Choose the source of the contracts.  Either current and/or 
archived contracts.   
 

Contract Status Choose to include contracts that are open and/or closed.  
 

Rental Status Choose the line types to include on a detailed report.  
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Conflicts Report 
 
The Conflicts Report allows you to preview your inventory requirements for the next month based on the 
current rental agreements outstanding and quotes or reservations made by your customers. Only those 
items which Rentals detects as not having sufficient quantities to meet the anticipated demand are 
printed on the report, allowing you to deal with inventory shortage situations on a case by case and 
customer by customer basis. 
 
To print this report, select Conflicts Report from the Reports | Management Reports menu.   
 
 

 
 
 
Field Description 

Conflicts between Select a range of dates, where potential conflicts will be 
reviewed 
 

Detail level Choose the level of detail to print.  Print in Summary or Detail. 
 

Presume items are returned x days 
late 

Choose the number of days late an item is presumed late.   
 
 

Generate new information Choose this option, to generate a new work file. 
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Delinquency Report 
 
The delinquency report is a concise listing of those items that are now considered overdue.  
 
To print this report, select Delinquency Report from the Reports | Management Reports menu.   
 
The report lists the Contact name and Phone number as well as the charges which will now be due upon 
return of the rental items. Use this information to contact the customers who have not returned their 
rented items. 
 
The report shows items and quantities still out.  New charges will be shown, if the items were now 
returned. 
 
Subtotal amounts by contract and customer are provided. 
 

 
 
 
Field Description 

Customers Select a range of customers that apply to these contracts 
 

Contracts Select a range of contracts to be printed.  If you’re attempting 
to print a single contract, set the contract to the starting and 
ending contract range.  No other range settings are required. 
 

List overdue items as of Choose the effective date for the report. 
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Tax Summary Report 
 
The Tax Summary Report provides a summary of all tax activity by tax group and within each tax group 
by jurisdiction and item and customer status, since data was last purged. 
 
If the report prints successfully to a printer or file, the data may be purged.  The option to purge data is 
set in the Company Profile. 
 
To print this report, select Tax Summary from the Reports | Management Reports menu.   
 
 

 
 
 
Field Description 

Tax groups Select a range of tax groups to be printed.   
 

Tax data last purged on The date of the last purge is display. 
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Commission Report 
 
The commission report provides a summary rental and sale revenue by salesperson.  Cost, profit and 
margin are reported.   Revenue from rentals and the sale of items are separated.  
 
To print this report, select Commission Report from the Reports | Management Reports menu.   
 
 

 
 
 
Field Description 

Customers Select a range of customers that apply to these invoices 
 

Salespersons Select a range of salespersons that apply to these invoices 
 

Invoices Select a range of invoices that will be included. 
 

Invoice dates Select a range of invoice dates that will be included. 
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Billing Reports 
 
Billing Reports can be accessed the Reports | Billing Reports menu. These reports are generally 
printed during the billing process. 
 

 Pre-Billing Register 
 Print Invoices 
 Invoice Audit Report 

 
For more information about these Billing Reports, refer to the related sections within this guide. 

 

Print/Consolidate G/L Transactions Report 
 
This report prints details of the General Ledger transactions that were created from posted contracts and 
invoices. 
 
The report can be printed either in a Detail format, which provides a more comprehensive report; or in a 
Summary format. You can also indicate how you want the report to be sorted: by Account, Journal 
entry, or Transaction date. 
 
Once you have printed this report, you can choose to consolidate the G/L transactions. For example, you 
may wish to consolidate all entries for a particular G/L account into one G/L entry. If you do this, when 
you retrieve the data into G/L you will have one entry instead of multiple entries for each account. 
 
There are several different consolidate options, allowing for consolidation based on date, fiscal period, 
and so forth. Select your preferred consolidation method, and, where applicable, the date as well. 
 
Alternatively, you can bypass the consolidate option and instead simply clear the G/L transaction data so 
that it’s not included on subsequent G/L Transactions reports. 
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New Rental Contracts 

Overview 
 
To enter a new rental contract, first open the Contracts window by selecting Contracts | Edit 
Contracts, or just click the Contracts button on the toolbar. 
 
This window displays all contracts sorted by contract number or customer, depending on the active sort 
order.  Right click over the grid to set the sort.  If you’ve selected Display in descending order in the 
company profile, the latest contract will be the first entry in the grid. 
 
Records in this grid may also be selected for display and sorted based on criteria you define in the Edit 
Contract Filters function. Please refer to the documentation regarding Contract Filters. 
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Rental Contracts 
 
To enter a new contract, click the New button on the Contracts window.  The New Contract window 
will open. 
 
 

 
 
 
Field Description 

Customer Select a customer for this rental contract 
 

Ship To Enter a valid Ship To code for this customer or choose one from 
the finder dropdown. 
 

Order date Select the order date for this contract.  The order date will 
default the other displayed dates. 
 

Expected ship date If you’ve chosen to display all dates in the Company Profile, you 
can enter an expected ship date. 
 

Receipt date If you’ve chosen to display all dates in the Company Profile, you 
can enter a receipt date. 
 

Rental period Enter the expected rental period for this contract.  For open 
ended contracts, leave the end date blank.  Rather than enter 
the end date, it might be more convenient to enter x days 
(weeks or months) in the field below.  Let Rentals set the end 
date. 
  

Reservation Select this option, if this contract will be a reservation.  Ie.  
Items aren’t rented or sold, until it’s changed to an active 
contract. 
 

 
 
Click OK when you have completed all the fields.  A new contract window will open, so that you can 
enter contract details.  There are several tabs:  Header, Detail, Bill To/Ship To, Notes and Total.  An 
optional field tab will also appear, if you’ve defined header optional fields in the Company Profile. 
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Header Tab 
 
The Header tab is where you enter general information about the contract.  This tab is divided into two 
sections:  Contract Information and Customer Information.   
 

 
 
Contract Information 
 
Field Description 

Contract number If you use the automatic numbering system, you will not be 
able to edit this field. A contract number will be automatically 
assigned when the contract is created.  
 
See the Contract Options tab of the Company Profile for more 
information on automatic numbering. 
 

Order date Enter the date for the contract. The New Contract dialog would 
have already prompted you for an order date.  The default is 
the session date. 
 

Expected ship date If you have an expected ship date, select that here. This date 
could also be useful for contract styles and filtering.  For 
example, you could filter contracts that were close to their ship 
dates. 
 
If the receipt date was not visible on the New Contract dialog, 
the default will be the order date. 
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Receipt date Enter the customer’s receipt date for this contract.  If the 
receipt date was not visible on the New Contract dialog, the 
default will be the order date. 
 

Rental period Enter the expected rental period for this contract.  Open ended 
contracts are permitted, by leaving the expected return date 
blank. 
 

Reservation Select this option, if you would like to create a reservation, 
rather than an active contract.  With a reservation, no items are 
sold, rental items are not transferred and no billing occurs.  At 
any point you can re-edit the contract and change the status. 
 

On hold Select this option, if you would like to place this contract on 
hold. If the customer for this contract has been put on hold in 
their customer file, this field will default to put the contract on 
hold as well. 
 
Note:  Placing a contract on hold is a good way to exclude a 
contract from billing. 
 

Purchase order Enter the customer’s purchase order number. 
 

Ship via Select an expected shipping method. A list of shipping methods 
can be prepared via Edit | Ship Via.  If your preferred 
shipping method isn't listed, you can simply type in a shipping 
method. The default will be retrieved from the customer record. 
 

Site code Choose a site code for this contract. It might be useful to 
organize contracts by site (project) code.  Refer to the 
documentation regarding Sites. 
 

Description Enter a description for this contract. 
 

Comments If desired, enter any additional comments in these two fields. 
 

Manual Use this field to assign a particular style to this contract. After, 
it will display in the Edit Contracts and Contract Inquiry grids 
with this style at all times, regardless of any Filter criteria the 
record satisfies.  
 
To remove the Manual style, select the Standard style from 
the dropdown field. Refer to the documentation regarding 
Styles. 
 

Automatic This field displays the style assigned the contract by a Filter that 
was run. At the time the filter was run, the record satisfied the 
filter's criteria. Filters are automatically updated when the 
contract is edited. (This style may be overridden by a Manual 
style setting.) Please refer to the documentation for more 
information about Contract Filters and Styles. 
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Customer Information 
 
Field Description 

Customer The customer number that you selected on the New Contract 
dialog will appear here and the customer name will appear in 
the field below. You can select a different customer, if required. 
If you do change the customer number here or on the Bill To / 
Ship To tab, many fields will be refreshed, drawing information 
from the customer file of the new customer entered. You will 
want to check all standard customer-based fields to verify that 
they are right, in this event. 
 

Name This field displays the customer name selected in the field 
above. 
 

Price level If items sold on this contract will be using a price level system, 
select the price level for this customer. When you select a 
customer in the field above, the default price level for that 
customer will appear here, but you can edit this for this 
particular contract using this field. 
 

Price list Select the price list to use for this customer.  When you select a 
customer in the field above, the default price list for that 
customer will appear here, but you can edit this for any 
particular contract using this field. 
 
Note: You can also select price list for each item sold on the 
contract when you enter contract details. 
 

Terms code Select the terms for this customer. When you select a customer 
in the field above, the default terms code for that customer will 
appear here, but you can edit this for this particular contract 
using this field. 
 

Reference You can enter any reference in this field.  
 

Contact This field displays the contact name for the customer when you 
select a customer in the field above. 
 

Territory Displays the territory code of the selected customer. You can 
edit this field if required. 
 

Salesperson Displays the default salesperson for this customer. You can edit 
this field when required 
 
Note: The Salesperson comes from the Edit Salesperson 
function in Adagio OrderEntry. 
 

Tax status Select this customer's tax status. 
 
Note: Tax Statuses are defined under Edit | Tax Types. 
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Tax group This field displays the customer's default tax group, but you can 
edit this field when required. 
 

Tax exempt 1 & 2 You can use these fields to record any tax exempt numbers for 
the customer. By default, the tax exemption numbers in the 
customer file will appear here. 
 

 

Details Tab 
 
The Details tab is where you can enter the contract details. The grid lists all details on the contract, with 
descriptions, quantity, price, start date, end date and type/status.  A rental item will either be IN or OUT.  
The other line types are EXP (Expendable), MSC (Miscellaneous Charge) and COM (Comment). 
 
To add a new detail to the contract, click the New button. To edit a detail line, select the line and click 
the Edit button. Either way, the Edit Detail window will open. 
 

 
 
Edit Detail window 
 
Regarding the first field, Detail type, there are six different detail lines you can enter: 
 

 Select Rental Item to add a rental item to the contract. 
 Select Expendable to add an item (for sale) to the contract. 
 Select Misc to add a miscellaneous charge to the contract. 
 Select Comment to insert a comment line on the contract. 
 Select Text to enter additional text in the contract's details section. 

 
Depending on what you select in the Detail type field, the window will change to accommodate. 
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Adding a Rental Item to the Contract 
 
To add a rental item to the contract, select Rental Item in the Detail Type field.  The Edit Detail window 
will appear as shown below. 
 

 
 
Field Description 

Item number Enter the Item code (or press FS and select the item from the 
Finder) you wish to rent to the customer.  If Rental Item 
Finder is selected in the Company Profile, the finder will display 
rental items.  Alternatively, the finder will display inventory 
items.  Adjacent to the item field is the unit number.  If you 
maintain a serialized rental inventory, enter the unit number for 
the specific rental item. 
 

Quantity Enter the quantity of this item being rented. 
 

Unit price When you select an item above, the unit price is automatically 
entered from the rental item’s rate table. You can edit this unit 
price if required. Enter the rent you wish to charge per charging 
cycle (hour/day /week etc.). 
 

Description The item’s description appears here automatically when the 
Item number is entered. It can be customized for individual 
item detail lines, if desired. 
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Start date Enter the date this item is being rented from. In the case of a 
quote or reservation enter the date that the customer expects 
to pick up the item. 
 

Start time Enter the time the customer rented the item. In the case of 
quotes or reservations, enter the time the customer is expected 
to pick up the item. 
 

Return date Enter the date the customer expects to return the item. The 
return (due) date is calculated from the rate you’ve selected. 
Items not returned by their due date will be reported on the 
Delinquency Report. 
 

Return time Enter the time by which the item must be returned. Due times 
are calculated based upon the rate selected for the item. If 
you’ve selected Default return time to start time in the 
Company Profile, the return time will default to the entered 
start time.  Alternatively, the return time will default to the 
current time.  Keep in mind that time differences will impact 
billing. 
 

Rate Select the Rate from the dropdown list of rates.  The rates 
shown, and their associated amounts, are determined by the 
rental item’s rate table.  To review the item’s rates, select Edit 
| Rental Items from the menu. 
 

Tax status Enter an item tax status for this item. The default will be the 
item’s tax status, but it can be changed if required. 
 
Note: Tax Statuses are defined under Edit | Tax Types. 
 

Category When you select an item for this detail line, the item’s category 
will appear in this field. You can, however, change the category 
if needed. Categories control the General Ledger distribution of 
rental revenue.  If you’ve selected Rental category finder in 
the company profile, the finder will display rental categories.  
Alternatively, the category finder will display inventory 
categories.  
 

Location The default rental location is set in the company profile under 
the Items tab.   
 
Use the information in the Qty on hand grid below to ascertain 
which locations have the items on hand, and then select a 
different location if needed. 
 
Rentals will transfer the rental item to location RNT when the 
contract is posted. 
 

Qty on hand When you select an item in the Item number field, this 
section of the window will automatically display locations that 
stock this item, and will indicate the quantity on hand in each 
location. A positive number indicates available stock, and a 
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negative number indicates back-ordered stock. Information 
about quantity on sales order and net quantity available is also 
displayed. The line at the bottom of this section totals the 
available items. The information presented here allows you to 
make a selection regarding the location from which the item 
should be shipped. You can ascertain which location(s) have the 
item in stock, and then enter the most appropriate location in 
the Location field above. 
 

Expected ship The default expected ship date on the Header tab of this 
contract will appear here, but it can be changed if needed for 
each item on the contract. 
 

Billable Enter the number of billable cycles you wish to charge for this 
customer. This is normally calculated from the amount of time 
the customer expects to have the item on rental. However, you 
may manually adjust it if necessary.   
 

Extension This field displays the total pre-tax item amount by multiplying 
the quantity shipped and the unit price. 
 

Billed so far This field displays the accumulated billed amount for this 
contract item. 
 

Remaining The remaining amount is calculated from the extended amount, 
less the amount billed so far. 
 

Extended weight This field calculates the estimated weight of the item by 
multiplying the quantity rented by the item’s unit weight. 
 

Unit cost This field displays the unit cost for the selected item.  The cost 
can be entered in Rental Item Maintenance for each billing 
method. 
 

Extended cost This is the Unit cost multiplied by the quantity based on the 
Unit of Measure selected.  You may modify your deemed cost 
for this line.  Use rental costing for profitability analysis.  The 
cost is set in Rental Item maintenance. 
 

Optional fields Optional field will be displayed if you’ve defined contract detail 
optional fields in the Company Profile. 
 

 
The Item button may be used to view the Rental Item information.  If you’ve selected View IC Items 
for Rental Items in the Company Profile, the Inventory item information will be displayed.  It is possible 
to hide the button for users within a particular Security Group.  Refer to the documentation for more 
information. 
 
The Availability button may be used to view rental item availability information.  Refer to the 
documentation for more information on the Item Availability Grid. 
 
Click OK to add the rental item to the contract. 
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Adding an Expendable Item to the Contract 
 
To add an expendable item to the contract, select Expendable in the Detail Type field.  An expendable 
is an item that is sold to the customer. Perhaps you sell consumable item along with the rental item. The 
Edit Detail window will appear as shown below. 
 

 
 
 
Field Description 

Item number Click the Finder button and select the item number here.  
 

Quantity Enter the quantity ordered in this field. The unit of measure is 
displayed to the right. You can edit this field if required. 
 

Unit price When you select an item above, the unit price is automatically 
entered here. You can edit this unit price if required.  
 

Description The item’s description appears here automatically when the 
item number is entered. It can be customized for individual item 
detail lines, if desired. 
 

Tax status Enter an item tax status for this item. The default will be the 
item’s tax status, but it can be changed if required. 
 
Note: Tax Statuses are defined under Edit | Tax Types. 
 

Category When you select an item for this detail line, the item’s category 
will appear in this field. You can, however, change the category 
if needed.  
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Location If Sales Location in the Company Profile has been set, that 
location will be displayed.  
 
You can use the information in the Qty on hand grid below to 
ascertain which locations have the items on hand, and then 
select a different location if needed. 
 

Qty on hand When you select an item in the Item number field, this 
section of the window will automatically display locations that 
stock this item, and will indicate the quantity on hand in each 
location. A positive number indicates available stock, and a 
negative number indicates back-ordered stock. Information 
about quantity on sales order and net quantity available is also 
displayed. The line at the bottom of this section totals the 
available items. The information presented here allows you to 
make a selection regarding the location from which the item 
should be shipped. You can ascertain which location(s) have the 
item in stock, and then enter the most appropriate location in 
the Location field above. 
 
Note:  Location RNT is used by Rentals to indicate rented 
quantity.  When tem are returned, the quantity is transferred 
back to the original location. 
 

Price list This field is only visible, if there are price lists on file.  The 
default price list set on the Header tab of this order will appear 
here, but it can be changed if needed for each individual item 
on the contract. 
 

Expected ship The default expected ship date on the Header tab of this 
contract will appear here, but it can be changed if needed for 
each item on the contract. 
 

Extension This field displays the total pre-tax item amount by multiplying 
the quantity and the unit price. 
 

Extended weight This field calculates the estimated weight of the item by 
multiplying the quantity by the item’s unit weight. 
 

Unit cost This field displays the unit cost for the selected item. 
 

Extended cost This is the Unit cost multiplied by the quantity based on the 
Unit of Measure selected. 
 

Optional fields Optional field will be displayed if you’ve defined contract detail 
optional fields in the Company Profile. 
 

 
You can also click the Prices button, which will show you how much the selected item will be priced at 
for each price level. This feature allows you to override the default unit price for the item and it can help 
you decide which price level is appropriate; or, it can allow you to select special sales prices when 
applicable. Additionally, you can Show History to display the pricing history for this customer when 
purchasing this item in Adagio OrderEntry. You can then use the Excel button to export the information 
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reported in the Show History grid to an Excel workbook.  Members of a security group that don’t have 
access to Inventory Items Cost Inquiry will not see Cost fields in the Show History grid. 
 
The Item button may be used to view information stored with the Adagio Inventory item record. It 
reports the same information as Inventory Items Cost Inquiry does.  It is possible to hide the button for 
users within a particular Security Group.  Refer to the documentation for more information. 
 
The Alt item (Alternate Item) button can be used to choose an alternate item number, as these 
alternate items are not displayed on the regular Item field finder.  
 
Click OK to add the item to the contract. 
 
 
Adding a Miscellaneous Charge to the Contract 
 
To add a miscellaneous charge to the contract, select Misc charge in the Detail Type field.  The Edit 
Detail window will appear as shown below. 
 

 
 
Field Description 

Misc charge Select the type of miscellaneous charge that you want to add to 
this contract.   
 
Note: Miscellaneous Charges are defined under Edit | 
Miscellaneous Charges. 
 

Description When you select a miscellaneous charge above, the description 
for that charge automatically appears in this field. However, you 
can enter whatever description you require. 
 

Amount The default amount for the miscellaneous charge appears in 
this field, but you can edit it when required. 
 

Tax status Enter an item tax status for this item. The tax status found in 
the item file is entered here by default, but can be changed if 
necessary. 
 
Note: Tax Statuses are defined under Edit | Tax Types. 

 
Click OK to add the miscellaneous charge to the contract. 
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Adding a Comment to the Contract 
 
To add a comment to the contract, select Comment in the Detail Type field.  The Edit Detail window will 
appear as shown below. 
 

 
 
Field Description 

Description Enter your comment in the description field. 
 

Insert as instruction Select this option, if you would like this text to appear as an instruction.  
Instructions typically appear on packing slips for the warehouse, but not on 
documents that are seen by the customer.  Alternatively, the text will be 
marked as a comment.  The printing of instructions and comments can be 
controlled on the print specification. 
 

Transfer to invoice Select this option, if you would like the comment to be transferred from the 
contract to the invoice, when generating invoices.  Alternatively, the comment 
will only appear on the rental contract. 
 

 
Click OK to add the comment to the contract. 
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Adding Text to the Contract 
 
To add text to the contract, select Text in the Detail Type field.  The Edit Detail window will appear as 
shown below. 
 

 
 
 
Field Description 

Text code Select the Text Code you want to use.  The Text will appear in the window so 
that you can confirm that you have selected the correct Text. 
 
Note: Text blocks are defined under Edit | Text. 
 

Description Once you’ve selected a Text Code, the lines of text will appear in this field.  Edit 
the text as required. 
 

Insert as instruction Select this option, if you would like this text to appear as an instruction.  
Instructions typically appear on packing slips for the warehouse, but not on 
documents that are seen by the customer.  Alternatively, the text will be 
marked as a comment.  The printing of instructions and comments can be 
controlled on the print specification. 
 

Transfer to invoice Select this option, if you would like the lines of text to be transferred from the 
contract to the invoice, when generating invoices.  Alternatively, the text will 
only appear on the rental contract. 
 

 
Click OK to add the text to the contract. 
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Bill To / Ship To Tab 
 
The Bill To / Ship To tab of the Edit Contract window displays the Bill To and Ship To addresses for 
this contract. 
 

 
 
The Bill To address is taken from the customer file.  If there is a permanent change in a customer’s Bill 
To address, you’ll want to edit the customer file.  If you only need to change it in rare circumstances, you 
can edit the address here as needed. You can view and edit the customer file by clicking the Customer 
button. Initially, when you enter the customer file this way, you will be in View mode and the customer 
fields will be grayed out and cannot be edited. However, you can click the Edit button to change to the 
edit mode and will be able to make the changes desired. 
 
The ability to edit customer files may depend on your user group rights. If you cannot click an Edit 
button, you may not have the right to change a customer file. 
 
Changes made to the customer file will not be activated for this contract; they will only appear on 
subsequent orders. 
 
The Ship To address defaults to either the customer’s Bill To address, or, if there is a Ship To address on 
file for this customer, with a blank Ship To code, then that address is assumed to be the default Ship To 
address.  
 
If you have additional Ship To addresses on file for this customer, you can change the Ship To address 
using the Finder button. Or, you can manually edit the address as needed. 
 
If you edit one of the addresses, this change will only affect this contract. If you want to permanently 
change a Bill To address, use the Edit Customer function. 
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Optional Fields Tab 
 
The Optional Field tab of the Edit Contracts window displays any optional fields you’ve set up in the 
Company Profile's Optional Fields tab. Enter the values for your optional fields as required. 
 

 

Notes Tab 
 
This tab allows you to enter notes for the new contract. This Notes tab works in the same manner as all 
notes features in Adagio modules. For more information on how to use the Notes function, see your 
Adagio Fundamentals manual. 
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Totals Tab 
 
The Total tab displays contract statistics, as well as totals for the current session. Most of the statistical 
fields are available for editing. 
 

 
 
 
Field Description 

Completion date Enter a completion date if the contract if all the rental items are 
returned and the contract is closed.  The contract can be 
reopened by clearing the completion date.  If the complete data 
is set, the contract is deemed to be closed. 
 

Last billing date Displayed is the last billing date for this contract. 
 

Previous billing date Displayed is the billing date prior to the last billing date. 
 

Total billed so far Display is the total billed to date for this contract. 
 

Min invoice amount Displayed is the minimum invoice amount for this contract. 
 

Amount topped up If you have selected the Minimum rental amount per invoice 
options, the difference between the minimum amount and billed 
amount would be the topped up amount.  For example, if the 
minimum invoice was $50.00 and the billed amount was 
$34.00, the topped up amount would be $16.00. 
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Number of invoices Displayed is the total number of invoices that have been billed 
against this contract. 

Number of lines Displayed is the total number of lines on this contract. 
 

Items out Displayed is the total number of rented items, still out. 
 

Current changes Displayed are totals for the current session.  The total number 
of lines and extended weight are also displayed. 
 

 
When you’re finished editing the tabs for a new contract, click OK to post the contract.   
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Rental Returns and Credits 
 
To return rental items or credit contracts, first open the Contracts window by selecting Contracts | Edit 
Contracts, or just click Contracts on the toolbar. 
 
Locate the contract using Find.  Click Edit on the Contracts window to display the Edit Contract window.  If 
you’ve selected Open existing contract to detail grid in the Company Profile, the contract details grid will be 
displayed. 
 
Select the rental item to return and click Edit adjacent to the detail grid to display the Edit Detail window.   
 

 
 
If this is a return, select Returned. If you are crediting a line, select Credit.  Review the detailed information. In 
particular, the quantity to return or credit, return date and amount.   
 
When you’re finished editing the contract detail, click OK to post your changes.   
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If the entire contract is to be returned (or credited), use the Return All (or Credit All) function.  These functions 
are available from the contract detail grid’s popup menu.  Right click over the grid to display the popup menu.   
 
It’s still advisable to review the lines, prior to saving your changes. 
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Item Availability 
 
The item availability function allows you to accurately manage and monitor your rental inventory 
requirements.  At a glance, you can see where items are rented, reserved, in service or unavailable. 
 
From the Inquiries menu, select Rental Item Availability or Availability from the tool bar. 
 
The Availability function is also accessible from the contract detail window.  Choose a Rental Item detail 
type, and then click Availability.  
 

 
 
 
The grid displays a floating date range of rental item activity.  By default, the date range is two weeks 
from the session date; however that can be changed in the company profile. 
 
A category field is provided to restrict the view to a particular category.  If the category field is blank, you 
will see all rental items.  This can be useful when you’re building a contract and you need a rental item 
from a particular category. 
 
By default, the availability grid is sorted by item number.  If you’re displaying all rental items, you can 
also sort the information by category.  Right click over the grid to set the sort order. 
 
Columns are provided for the rental item number, description, category, status and available quantity, 
however those are selectable in the company profile. 
 
The cells in the grid are color coded, depending on the item status.  An item could be Available, 
Rented or Reserved.  From Rental Item Maintenance, you can set an item to be In Service, Not 
Working or Sold.  Each status has its own assigned color.  The colors can be customized in the 
Company Profile.   
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To update the grid information, click Refresh.  A refresh will be required, after a change to the date 
range or category.  If multiple users are changing contracts, a periodic refresh might be required.   
The grid will display the contract number where the item is referenced.  The item could be referenced on 
multiple contracts on a particular day, but only one is displayed.  Double click on cell to view the contract.  
Drilldown inquiry is also provided for the item, by double clicking on the item number. 
 
The grid’s popup menu provides additional functions.  You can refresh the grid, view the rental item, view 
the inventory item, view the contract or start a new contract from the highlighted item. 


